SUPER NATURAL

Super Natural

Administration
Version 3.3.1 for Mainframes

IIIIIIIIIIIIII



Order Number: NSN331-040I1BM

This document applies to Super Natural Version 3.3.1 and to all subsequent releases. Specifications
contained herein are subject to change and these changes will be reported in subsequent release notes or
new editions.

© November 2000, Software AG
All rights reserved

Software AG and/or all Software AG products are either trademarks or registered trademarks of
Software AG. Other products and company names mentioned herein may be the trademarks of their
respective owners.



Super Natural Version 3.3.1 Administration

Table of Contents

Super Natural Administration: Documentation Overview .
Super Natural Administration: Documentation Overview
Introduction
Introduction
Administration Appllcat|on OverV|eW
Administration Application User Interface
Object List Screens .
> Navigation .
Invoking the Super Natural Adm|n|strat|on Appllcatlon
Invoking the Super Natural Processor Application from the Adm|n|strat|on Appllcatlon
Command Overview
Users
Users

What are Users’>
Default Usep*x**x
Modifying the Default User
User Profile
Listing Users
User IDs

Super Natural Wlth Natural Securlty
Super Natural without Natural Security

Adding Users :
Modifying Single Users.

Options

Files .

Profile

Layout
Modifying Multiple Users
Copying Users .
Deleting Users .
Importing Users .

Files
Files

What are F|Ie Prof|les’>
File Lists . :
Listing File Profiles .
Adding Files .
Modifying Single Files .
Options
Users .
Copying Files
Deleting Files
Importing Files .

Superfiles

Superfiles
What are Superflles’?
What are Superfile Profiles?

OO OWOWOVONNNNOOCDUOPRRWWWNDNNPRE PR



Listing Superfiles
Adding Superfiles .
Options .
Users
Deleting Superflles

User Files .

User Files

What are User Flles’>
What are User File Profiles?
Listing User Files
Modifying User Files
Options .
Users
Deleting User Flles

Libraries

Libraries .

What are lerarles’?

Creating Libraries .

Listing Libraries

Copying Libraries

Deleting Libraries

Listing Library Members .
Copying Library Members .
Deleting Library Members .
The Information / Info Function .

Common Library Definitions

Common Library Definitions

What are Common Library Def|n|t|ons’>
Listing Common Library Definitions .
Adding Common Library Definitions.
Deleting Common Library Definitions

Special Services

Special Services .

Invoking the Special SerV|ces Menu
Importing Users

Importing Files .

Modifying Multiple Users

Layout Standard Title

Editing the Layout Standard T|tIe Element.

System Variables
S Lines .
Deleting the Standard T|tle
JCL Members . : :
Invoking the JCL Members Functlon .
Deleting JCL Members
Editing JCL Members.
Listing JCL Members.
Printing JCL Members
Renaming JCL Members.
Writing JCL Members

Super Natural Version 3.3.1 Administration

47
43
48
52
56
57
57
57
57
58
58
59
62
65
66
66
66
67
67
68
69
70
70
71
71
74
74
74
74
75
75
77
77
77
78
79
80
82
82
83
83
83
83
83
84
84
84
85
85
85



Super Natural Version 3.3.1 Administration

Batch Processing . . . . . . . . .. ... 86
Batch Processing. . . C e 86
What is Batch Processmg’> C e 86
Setting Up Batch Processing . . e 87
Setting Up Batch Processing for Remote Job Entry RJE e 88
Writing JCL Members . . . . . . . ... ... 88
Special Characters . . . . . . . . . . ... .. 88
Maintaining JCL Members . . . . . . . . . . . . .. 89
Notes for Natural Security Users . . . . . . . . . . . . . 89
Job Submission . Ce e 91
Submitting Batch Jobs Usmg Natural PROCESS Ce e 91
Modifying Submitted Batch Jobs-SPRJELU . . . . . . . . . . 91
Batch Utilites . . . . . . . ... L. 92
Batch Utilities. . . C e 92
What are Batch Ut|||t|es’> . C e 92
Unloading and LoadingSuper Natural Data Ce 92
SNULD . . . ..o 93
Functions . . . . . . . ... L. 93
Parameters . . Ce e 94
Examples of Recommended Syntax Ce e 94
SNLOAD . . C e e 95
SNDELUF2 - Deletlng User Flles in Batch e 95
parameterl . . . . . ... ... 96
parameter2 . . . . ... ... 96
parameterd . . . . ... ... 96
parameterd . . . . . ... ... 96
parameter5 . . C e 96
SNSORTFI - Sorting F|Ie L|nks in User Proflles e 96
parameter . . . . .. ... 97

Exit Programs . . . . . . .. ... 98
Exit Programs . . C e e 98
What are Exit Programs’? C e e 98
User Exits . . . . . . ... 98
Writing User Exits . . C e 99
Storing User Exit Object Modules Ce e 99
System Exits . . . . . . . . . . . . . . . . . . oo
Technical Informaton . . . . . . . . . . . . . . . . . 10
Technical Information. . . . . . . . . . . . . . . . . 101
Super Natural and Natural . . . . . . . . . . . . . . . 101
Programs . . T ok
Libraries and Preflxes e X0 14
Natural Security Considerations . . . . . . . . . . . . . 102
System Components. . . . . . . . . . . . . . . . 103
DDM Field Names . . . . . . . . . . . . . . . . 104
Natural Profile Parameters . . . . . . . . . . . . . . 104
Data Selection and Performance . . . . . . . . . . . . . 104
COUNT Function. . . . . . . . . . . . . . . . . 105
VALUE Function. . . .. . 105
Performance Considerations for Mlxed Format Calculat|on Expresswns .. . 105
Sort . . . . . . . . . . . . . . . . . . . . 106

SORTSZE . . . . . . . . . . . . . . . . . . 106



Super Natural Version 3.3.1 Administration

Personal Database.
Error Logging
Possible Errors
Listing Error Reports .
Showing Error Report
Deleting Error Reports
Printing Error Reports
Maintaining Error Reports
Migrating old Error Reports
DDM Check on Modify .
Results of Checking .
Criteria of Checking .
Change of References . .
Modes of DDM Check on Modlfy
Enable DDM Check on Modify .
Phases of DDM Check on Modify.
Status Reports . . .
Displaying Status Reports
Browsing Status Reports .
Deleting Status Reports .
Printing Status Reports .
Super Natural RPC Service Functlonallty
Introduction . :
Hints and Limitations.
Dynamic Input Fields within the RPC Serwce
Generate an RPC Service - Server Side .
Resulting RPC Service Source
Create the Client Side Parameters
Memory Requirements .
Communication with Other Appllcatlons
The Technical Information Function.
Layout Members
Passwords and Cipher Code

User Profile, Option and Adabas Password Hlerarchles .

User Profile Hierarchy
Option Hierarchy. .
Adabas Password Hlerarchles

106
108
109
109
112
117
118
118
122
123
123
124
125
125
126
126
128
128
131
136
137
137
137
138
139
139
142
147
148
150
151
151
151
152
152
152
152



Super Natural Version 3.3.1 Administration Super Natural Administration: Documentation Overview

Super Natural Administration:
Documentation Overview

This documentation covers the following topics:

Introduction

Users

Files

Superfiles

User files

Libraries

Common library definitions
Special services

Batch processing

Batch utilities

Exit programs
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Technical information
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Introduction

This section introduces you to the Super Natural Administration Application.
This section covers the following topics:
® Administration Application Overview
® Administration Application User Interface
® |nvoking the Super Natural Administration Application
® Invoking the Super Natural Processor Application from the Administration Application

® Command Overview

Administration Application Overview

Super Natural administration is an independent application with its own command processor. The users’
part of Super Natural is called the Super Natural Processor.

The Super Natural Administration Application has three distinct sections as shown below:

Admn istration Application

SUPER MATURAL
Users, Fles and Libranes

~—

MATURAL REPORT MANAGER

Layout Options and Standard T ile

MATURAL

\ JOL Merbers —/

® Super Natural
You use the main part of the Super Natural Administration Application to maintain users, files (files,
user files and superfiles) and libraries (public, common and private). The user interface conforms
with the Super Natural Processor application.
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e Natural Report Manager
Parts of Natural Report Manager are incorporated. You can modify a user’s layout options using part
of the Natural Report Manager Profile function. You can modify the Standard Title for your site from
the Special Services menu using the Layout Editor.

e Natural
The NaturaLIST command is incorporated. Choosing JCL Members from the Special Services
menu is the same as issuing the following Natural commands:
LOGON LIBRARY ZJCL
LIST *

Administration Application User Interface

The user interface for Super Natural 3.1. uses menus, screens and windows.

Object List Screens

Instead of the Description column found in the Processor application, the object list screens in the
Administration Application have various information columns and do not have the Library and Library
Type fields as shown below:

— Command Column

Marme Column
|7 |— Start VYalue Field/— Information Columns

l/_13: == ®EEEEE SR UER WEERES =05 =21 -\
- or Idix - SHHIL
Hzzm ! <

HA xor ID Tilox Hintonanco
A m——

__ Emmz=ExZax 1 H

__ R 1 H

__  HA 1 H

_ mEl 17 H

__ hR2 17 H

__  RRS 17 ¥

FAR4 1= H

= 17 H

__ RRE 17 H

__  RR7 17 H

__ mRT 1= H

__ RR= 1= H

__ RRs1 1= H

&
Gd| x| fdd, Hedify, Sepy, Inloto
Faloct oo coHHard | fron lizt
CoHHATA ===
ETtor-FPrl-—rFF2——¥Fri:——rr4—-—FrFr4——rFff——FprPr*——rFF%——FPFo—-FF10—7FFll ——FFl 2——
Halp Fxit Ilip < Zanc

N /
L

— Add Feld

Legend

> Navigation

The Modify Object screens and the Import Files Object list screen have > navigation fields for navigating
between groups of settings or object types in the bottom left-hand corner of the processing area as in the
sample below:
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/_13:55 EXTET ZUPFEER HMATURAL XXX X 122X-0%-21

— Hasdify zor ARK =0ptlonz - TRHMHD

Huintmnarco Futheorization ~ Ianguago ~ Frnfianz
froxr - Mudbarxr - lUror TFilor

Intalmzo fccozz

Imtalmrno Aecorx and J2L

Inta Huirntonanco TrarxacHeoen Typo < Imta Folactdom
Jopzsrt Typan < Fapsrt Iawol

Foporst Imxtisation -~ Funm Hedo - Eatch J=b Entxy

Idzxplay Optiomz

—Fr4——FI™ ——FE 5= —FF7———F 5——FF3———FF1lO0—FF1l ——FFl I——
Iiip Zanc

~

/

N— =Maviaation Felds

» To navigate between groups of settings or object types using > navigation:

o Mark the appropriate > navigation field with the cursor position or any non-blank character and press

Enter.

Or:

Issue one of the following commands as appropriate:
O >OPTIONS

O >PROFILE

O >USERS

O >PUBLIC

O >FILES

o >LAYOUT

O >PRIVATE

Note:

For further information on using the new Super Natural user interfacesgeg Super Naturalin the

Super Natural User’'s Guide

Invoking the Super Natural Administration Application

» To invoke the Super Natural Administration Application from a Super Natural session:
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e Select the functioBuper Natural Administration on the Processor Main Menu.
Or:
Issue theMAINTENANCEommand from the Main Menu.

The Administration Menu appears:

13:56 *rxxx Super Natural ***** 1999-05-21
- Administration Menu - SNMO04
USER Users
FILE Files

SUPER Superfiles
USERF User Files

LIB Libraries
COMM Common Libraries

SPEC Special Services

PROC Super Natural Processor

Select Object

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF 7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

Invoking the Super Natural Processor Application from the
Administration Application
» To invoke the Super Natural Processor application from the Administration Application:
® |ssue thePROCESSORommand.
The Super Natural Processor Main Menu appears.

You can use thEROCESSOR Super-Natural-command command to execute Super Natural
Processor commands directly from the Administration Application.

» To execute a Super Natural Processor command directly from the Administration Application:
® |ssue thd?ROCESSOR Super-Natural-command command.
The Super Natural Processor command is executed.

Note:
You return to the Administration Application via the Super Natural Menu.
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Command Overview

User |File | Super| User File | Lib. Lib. Member |Lib. | Standard Title | JCL
file V) (P) © Lib.

X X X

ADD
MODIFY
COPY
DELETE
INFO X
IMPORT
MULTIMOD | X X
MEMBER X
EDIT X
LIST
PRINT
RENAME
DISPLAY X
TEST X

X | X | X | X
X | X | X | X

X
X X X
X

X

X | X | X | X

As users of this documentation should already be familiar with using Super Natural, only direct
commands are documented. For alternative methods of issuing commarndisingeguper Naturalin
the Super Natural User’s Guide
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Users

This section covers the following topics:
® \What are Users?
® Default User ¥k
® User Profile
® Listing Users
® User IDs
® Adding Users
® Modifying Single Users
e Modifying Multiple Users
e Copying Users
® Deleting Users

® Importing Users

What are Users?

Each Super Natural user has a user ID and a user profile. User profiles consist of settings for options, files,
profile and layout. These settings influence the appearance of screens, and many technical details
concerning the environment, output and processing of transactions.

You can adapt the settings for each user of Super Natural to suit his or her individual requirements. You
can either use the settings in the default user profifé**  or change each setting individually. You
can also change all users at once.

Note:
A user must be authorized to use at least one library.

You can perform the following commands on the object user:

ADD MODIFY COPY DELETE IMPORT MULTIMOD

User |X X X X X X

Default User*******

Software AG supplies a default user profile with the usettB&¥**  with Super Natural (known as
global options in previous versions). When you define a user, the default user profile*sftiser is
copied to the user ID you have specified.
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You can not delete the default user.

Modifying the Default User
You can modify the default us&r=***  supplied by Software AG to suit the needs at your site.

When you add or import the next user, any modifications you have made to the options and file list of the
default user are copied to the user ID you have specified. The standard profile and layout settings provided
by Software AG are always copied to new users created withdth@r Import functions.

When you create a new user by copying the default user, any modifications you have made to the default
user’s profile and layout are copied to the user ID you have specified in addition to the modified options
and file list.

User Profile

The Super Natural user profile settings are organized into four groups of equal status as shown in the
following diagram:

A0D
MODIFY | USER
COPY <
Cptions - |—{  Fies FProfile —{ Layout

Listing Users

» To obtain a list of users currently defined to Super Natural:
® |ssue thdJSERcommand.
Or:
Select the object User from the Administration Menu.

The User List screen appears:
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13:57 **kk% Super Natural ***** 1999-05-21
- User List - SNMUL
More: +
Cmd User ID Files Maintenance

*

*kkkkkk 1 N
A 1 N
_ AA 1 N
_ AAL 17 N
_ AA2 17 N
_ AA3 17 Y
_ AA4 18 N
__ AA5 17 N
— AAG 17 N
_ AA7 17 N
_ AA8 16 N
— AA9 15 N
~ AA91 16 N
Add

Cmd(s): Add, Modify, Copy, Delete

Select one command from list

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The User List screen shows the following:
O List of the users defined to Super Natural
O The number of files each user can access

O Whether each user is authorized as an administrator.

User IDs

Before you can add a user, you must decide which user ID to give him. The user IDs you can allocate
depend on whether you are running Super Natural under Natural Security or not.

Super Natural with Natural Security
» To use Super Natural with Natural Security
® Use the user’s Natural Security logon ID.

You can not override this.

Note:
If you import a user whose Natural Security logon ID is longer than 7 characters, it is truncated.

Super Natural without Natural Security

» To run Super Natural without Natural Security
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e Use the user's TP monitor user ID.
Or:
Use another ID of up to 7 non-blank characters.

In this case, a screen appears which asks you to enter an ID valid only for Super Natural. User IDs
created like this are not password-protected. Each time the user accesses Super Natural, a logon
screen appears where he must enter his Super Natural user ID.

Adding Users

» To add a user:
® |ssue theADD USERuser-ID command

Whereuser-IDis the ID of the new user.

The default user****** g copied to the user ID you specified and the Modify User >Options
screen appears. You can now modify the default user settings for the user you have created. For
further information, se®odifying Single Users.

Note:
Natural Security users can also uselthport User  function to define users to Super Natural.

Modifying Single Users
» To modify a user:
® |ssue theviODIFY USER name command.

The Modify User >Options screen appears:

10
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17:23 Rk Super Natural ***** 2000-06-16
POR - Modify User POR >Options - SRMUMO

Maintenance Authorization / Language / Prefixes
Sizes / Numbers / User Files

Database Access
Database Access and JCL

Data Maintenance Transaction Type / Data Selection
Report Type / Report Level
Report Destination / Run Mode / Batch Job Entry

Service Generation Options
Display Options

>Files >Profile >Layout

Mark function(s) or select by cursor

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

4AA! 22,015

You can either modify the user options or select one of the following setting groups using
Navigation

O File
o Profile
O Layout

Note:
For information on navigating between profile setting groupsNse&ating Between Profile Setting
Groups.

» To modify a user default setting:
1. Overtype it.
2. Press Enter.

Note:

Users must restart their Super Natural sessions before your modifications are valid.
Your modifications are valid for all new transactions but not for existing ones.

Options
When you chooseOptions , the Modify User >Options screen appears.

» To modify user options:

11
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=

. Mark the group(s) of options you want to modify.

N

. Press Enter.
3. Overtype existing entries as required.
4. Press Enter.

You can modify the following user options:

Note:
Options which the user can modify her or himself are marked with an asterisk (*) in the following list.

Maintenance Authorization / Language / Prefixes

12
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Option

Users

Description

Authorized for "Y" indicates that the user will be a Super Natural administrator. "N" indicates th. t the

Maintenance

Language
Code*

Private Library

Public
Libraries

Common
Libraries
Transaction

Programs

Layouts

Prototype
Programs

Application
Programs

Data Models

user will not be a Super Natural administrator. Default value = N

Indicates the language to be used for error messages, text constants, screens, |
and commands. For example,” 1" indicates English and "2" indicates German D

value = 1. If Super Natural is available in one language only, the Language Coc

setting in all user profiles must indicate this language.

"Prefix: "Super Natural assigns a prefix to the ID of each private library. If you le
the prefix blank, the user will have no private library and will be offered a choice
the public or common libraries he is authorized to use when he logs on to Super
Natural. If he is not authorized to use any public libraries, the user can choose w
common library he wants to access. Default value = Y You can not assign the s
default prefix to private and public libraries.

"Prefix:" Super Natural assigns a prefix to the ID of each public library. If you lea
the prefix blank, the user will not be authorized to use public libraries. Default va
z

"Prefix:" The common library prefix is assigned3®PARMvhen Super Natural is
installed and can not be modified here. Default value = C (non-modifiable)

"Prefix:" Super Natural assigns a prefix to the ID of each transaction program. D
value = | Max. "Numbers:" The maximum number of transactions permitted withi
private library. Default value = 999

"Prefix: "Each transaction has a layout member with the name layout-prefix
transaction-name. The layout member is in copy code. The layout prefix is assig
SPPARMvhen Super Natural is installed and can not be modified here. Default \
= L (non-modifiable)

"Prefix: "Super Natural assigns a prefix to the ID of each prototype program. Dei
value = X Max. "Numbers:" The maximum number of prototype programs permit
within a user library. Default value = 35

"Prefix: "Super Natural assigns a prefix to the ID of each application program. D
value = A Max. "Numbers:" The maximum number of application programs perrn
within a user library. Default value = 35. Other Applications access If you leave 1
program prefix for applications blank, users are not able to access Application
Programs. Therefore there is no entry Application Programs on the Menu.

"Prefix: " Super Natural assigns a prefix to the ID of each data model. Default ve
M Max. "Numbers:" The maximum number of data models permitted within a us
library. Default value = 35

Sizes / Numbers / User Files

alp texts
fault

b

ve

lich
mne

fault
1a

led in
lue

wilt
ed

fault
tted
e

Je =
r
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Description

Online Screer Determines the screen size to be used when producing reports using Online Run

Size*

Printer Page
Size*

Logical
Printer
Number*

Work File
Number*

Personal
Computer
Number*

User File
Adabas
Database ID

User File
Adabas File
Number

User File
DDM Prefix

Maximum
Number of
User Files

User File
Retention
Period

"Depth:" The number of lines. Default value = 24 The depth may not exceed the
physical screen size of the terminal. "Width:" The width must exceed the display
length by at least 1.

Determines the page size to be used when producing reports using RuBAViacidor
DestinationPRINTER "Depth: "The number of lines. Default value = 60 The deptt
may not exceed the physical page size of the batch printer. "Width:" The number

characters per line. Minimum value = 80 Maximum value = 250 Default value = 1

The width must exceed the display field length by at least 1.

Number of the printer to be used for report/logging destination PRINTER. There i
separate settings f@NLINE andBATCHRun Mode.

"Read:" Work file number from which data is to be received in data selection moc
WORK FILE. "Write:" Work file number to which data is to be sent with report
destination’VORK FILE.

"Read:" Personal computer number from which data is to be received in data selt
modePC "Write:" Personal computer number to which data is to be sent with rep:
destinatiorPC

Database ID (DBID) of the physical Adabas file to be used as the Super Natural
personal database for user files. For Natural Version 2.2 or Version 2.3 under Ad
Version 5, the range is 0 - 254. For Natural Version 2.3 under Adabas Version 6
range is 0 - 65535 Default value = zero . Do not enter a database ID if you think
may want to change it in the future. You can not change the database ID for exis
transactions!

File number (FNR) of the physical Adabas file to be used as the Super Natural pe
database for user files. For Natural Version 2.2 or Version 2.3 under Adabas Ver
the range is 1 - 255 For Natural Version 2.3 under Adabas Version 6 the range is
5000. The value zero indicates that no user file is defined for the current user.

Super Natural assigns a prefix to the name of each file created by a user. Defaul
=UF.

The maximum number of user files permitted per user. Default value = 255 .

Time limit for user files in years, months and days. User files are deleted when th
have existed for the time specified in this option. Default value = blank (no time li
defined).

Database Access

Option Description

Multi-File "Y" indicates that multiple-file transactions are allowed. "N" indicates that
Transaction  multiple-file transactions are not allowed. Default value = N .

Allowed

14

mode.

eld

re

ction
rt

bas
e
ou

ng

'sonal
ion 5,
1-

value

Yy
it



Super Natural Version 3.3.1 Administration Users

Option

Description

Physical Read "Y" indicates that a physical read of an entire file is allowed if required by the

Allowed

transaction’s selection criteria in Online Run mode. "N" indicates that a physical read
of an entire file is not allowed. There are separate settings for Online and Batch un
mode. Default values =Y. This option must be set to "NDiof | files.

Non-Descriptor "Y" indicates that a transaction may use selection criteria that contain non-desc ptors,

Criteria
Allowed

Maximum
Number of
Criteria

i.e., fields that have not been defined as key fields. "N" indicates that the transa tion
may only use selection criteria comprised of key fields. There are separate setti gs for
Online and Batch Run mode. Default values =Y .

The maximum number of criteria permitted within a transaction. There are sepa ate
settings for online and batch run mode. Default values = 99

Display Values "Y" indicates that the user can use the Values for Key Fields functions which is
For Key Fields available from the Information column of the Worksheet. "N" indicates that the L ser

Allowed

Processing
Sequence*

may not use the Values for Key Fields function. Default value = N .

Used to control the order in which the following are processed: File look-up (F),
Calculations (C), Logical conditions (L), inter-field Arithmetic (A), external Sort ( )
and Updating records (U) during transaction processing. Default sequence = F( LASU

15
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Description

Flatten
Repeating
Fields*

System
Functions per
Outer

Loop*

Specifies when the individual occurrences of multiple-valuefields or fields conta
in a periodic group should be presented as individual records when changing di
a report or updating data." B" indicates flattening before processing : When you
data maintenance or data change transaction using this option, Super Natural c
a flattened version of the selected data for editing. The occurrences of periodic
are presented one at a time as individual records which you can update or char
Once you have updated or changed a record, you are shown how it will be outp
in flattened form) before moving on to the next record. "A" indicates flattening a
processing (only available for data change): when you run a data maintenance
change transaction using this option, Super Natural displays a continuous list of
selected data for editing. All occurrences are numbered. Once you have update
changed a record, you are shown how it will be output before moving on to the
record The data is flattened and each occurrence is displayed as a separate re«
"blank" indicates that no flattening is to be performed: when you run a data
maintenance or data change transaction using this option, Super Natural displa
continuous list of the selected data for editing as for flattening after processing.
you have updated or changed a record, you are shown how it will be output bef
moving on to the next record. The data is not flattened. Default value = blank

Before flattening

Ekmentary Fieki h'ILIIIiph Walle Fekd
Mame] [-Jl.‘lhTi:Ie] »'".I’,

|| H E b

)’- /

vlhe

Afrer flatening

T Erem A [ ﬁl"' o
|_p e | ﬁv[:H l“vl n ]

I W AR I

Defines the evaluation of system functions used for control break processing wi
two files have been linked for the transaction. "Y" indicates that system function
to be evaluated for all records found in the primary file (outer loop). "N" indicate
system functions are to be evaluated for all records found in the secondary file |
loop). Default value = N . The above is only relevant if two files are linked via th
File Selection screen. If more than two files are linked via the Lookup function (.
system functions are processed per outer loop.

Adabas Sortinc "Y" indicates that the Adabas internal sort feature may be used for a transactior

Allowed

contains sort criteria comprised of one to three key fields. "N" indicates that the
Adabas internal sort feature may not be used. Default value =Y . There are seg
settings for online and batch run mode. This option must be set to "NLfdrfiles.

Buffer/External "Y" indicates that a buffer or external sort feature may be used. "N" indicates th:

Sorting
Allowed

16

buffer or external sort feature may not be used. Default value =Y . This option ¢
separate settings for online and batch run mode.
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Database Access and JCL

Option Description

DDM "Y" indicates that each time a Super Natural transaction is modified, a check is mi de to
Checking on see if the transaction is still consistent with the data definition module (DDM) for tl 2
Modify file or files involved. A warning is issued when a user modifies a transaction if the JDM

has been changed." N" indicates that no check is to be made. Any changes made to the
DDM since the transaction was created/last modified are ignored. The default is M

Maximum  The maximum number of records that may be processed for a transaction. If you ‘:ave

Number of this setting blank, Super Natural will not enforce any limit on the number of record :

Records processed. This option allows separate settings for online and batch run mode. D fault
value = 999999 Users can reduce the maximum number of records to be read for est
purposes by changing the transaction option Number of Records to be Read usin the
OPTIONScommand for each transaction separately.

Maximum  The maximum number of pages permitted for a transaction report. This option allc vs
Report Page: separate settings for online and batch run mode. Default values = 9999

Adabas If an Adabas file which is security protected is to be available to Super Natural
Password transactions, the password for the file must be provided. Séel#ims Security
documentatiorior additional information on Adabas security.

Adabas If an Adabas file which is ciphered is to be available to Super Natural transactions the
Cipher Code cipher code for the file must be provided. SeeAtiabas Security documentatitor
additional information on Adabas ciphering.

JCL ID Any user-given name. By default, eatfL/JCS member is stored in the libraBJCL .
Default value = JCLO1

Transaction Mode Settings

The following groups of settings concern the user’s transaction modes for data maintenance and for
reporting:

e Data Maintenance Transaction Type / Data Selection
e Data Change / Report Type / Report Level
® Report Destination / Run Mode / Batch Job Entry
» To authorize the user to use a mode:
e Enter "Y" next to the entry.
» To prevent the user from using a transaction type:

e Enter" N" next to the transaction type entry.

» To define the user’s default for each group of transaction modes:

17
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e Enter the corresponding character in the Default field.
Data Maintenance Transaction Type / Data Selection
Data Maintenance Transaction Type:

Note:
The data maintenance functions are intended for use on user files only, not on produivtothade.

Transaction Description
Mode

Reporting (I)  Allows the user to execute reporting transactions.

Add Records  Allows the user to add records to a file (corporate file or user file) provided the
(A) corresponding authorization level has been assigned for the file to be used.

Update Record: Allows the user to update records in a file (corporate file or user file) provided tl 2
V) corresponding authorization level has been assigned for the file to be used.

Delete Records Allows the user to delete records from a file (corporate file or user file) providec the
(D) corresponding authorization level has been assigned for the file to be used.

Edit Data (E) Allows the user to use the data editor for updating records. Default mode settin = |

Data Selection:

Transaction  Description
Mode

Full-Screen  The user can enter selection criteria using the Selection Editor.

(F)

SQL Select (S Users of DB2 and SQL/DS can access the SQL SELECT Editor to write SQL
SELECT statements. Super Natural does not check whether Natural DB2 is inst lled.
If Natural DB2 is not installed, the user can still access the SQL SELECT Editor nd
write SELECT statements. However, when YSHECKRUNor SAVEthe transaction
a Natural syntax error occurs (even if the syntax would be correct for SQL).

Data from Allows the user to read data from a work file.
Work File (W)

Data from PC Allows the user to read data from a PC file. Default mode setting = F
File (P)

Data Change/Report Type/Report Level
Report Data Change Mode

18
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Users
Transaction Description
Mode
Map (M) The user can use an automatically generated map to change data for a report. C ita
stored in the file or database is not affected by this change mode. For example, 1e user
can use this mode to modify data before sending it to a user file or a printer.
None (N) Data may not be changed for a report. Default mode setting = N
Report Type

Transaction Mode Description

List (L) Report data is displayed with a title (optional) and column hez lers.
Vertical List (V)  The report is displayed vertically (one or more pages per reca d).
Table (T) The report is displayed in tabular form.

Con-Nect (C) The report is processed by Con-Nect. Default mode setting = .

Report Level

Transaction  Description
Mode

Detail (D) "Y" indicates that all output is desired.

Summary (S) "Y"indicates that only the information that results from a control break is shown n

the report. If no system functions are defined at control breaks, the records foun | are
counted. Default mode setting = D

Logging

Transaction Mode Description

Data Maintenance The logging mode for data maintenance transactions can be set to the folli wing
Logging values:

"Y" indicates that the logging option for data maintenance transactions is
enabled and set to to the default value Y.

"N" indicates that the logging option for data maintenance transactions is
enabled and set to the default value N.

"P" indicates that the logging option for data maintenance transactions is
disabled and no logging can be specified by the user.

"F" indicates that the logging option for data maintenance transactions is a vays
performed.
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Report Destination / Run Mode / Batch Job entry

Report/Logging Destination

Transaction
Mode

Description

Screen (S)
Printer (P)

Editor (E)

Work File
(W)

PC File (F)

User File (U)

Display on the user’s screen.

Report data is routed to a printer. Output may be routed to a printer only if Com-F
Natural Advanced Facilities is installed at the user site. Output may be routed to ¢
only if Entire Connection is installed at the user site.

Report data is written to a Natural editor source program work area. Once the out
been placed in the source program work area, the Natural editor is invoked and n
then be used to edit and, if desired, to save the output in a Natural library. "Y" ind
that destination EDITOR is available. "N" indicates that destination EDITOR is no
available. Default mode = N. If the EDITOR option is disabled, the user may not
generate prototype programs.

Report data is written to a Natural work file. If any setting other than "N" is entere

ete or
PC

)ut has

y
sates

number that represents the logical identification of the sequential work file must b

defined as described in the section Setting Global Options. Be sure to check whe
your environment supports the use of work files. ISawiral Installation and
Operations documentatidior further information on the usage and assignment of
sequential work files.

Report data is transferred to a Personal Computer (PC). If any setting other than
entered, a number that represents the logical identification of the personal compt
must be defined as described in the se@etiing Global Options This feature is onl
supported if Entire Connection is installed at the user site. The connection betwet
host and the PC must be activated by entering "%+".

The transaction data is written to a user file, that will be generated automatically ¢
transaction execution. The use of the user file feature is only supported if Adabas
installed at the user site.

Con-Nect (C) The report is written as a document to a Con-Nect system folder where it can be

Run Mode

Transaction
Mode

processed using Con-Nect. The use of this feature is only supported if Con-Nect
installed at the user site. Default mode setting = S

Description

Online (O)

Batch (B)

20

ONLINE run mode permits the creation and execution of transactions from an or
terminal. "Y" indicates that online mode is available. "N" indicates that online ma
not available. The defaultis Y .

BATCHrun mode may be used to submit a transaction for execution in batch mo
using a remote job entry facility. "Y" indicates that batch mode is available." N"
indicates that batch mode is not available. Default mode setting = Y
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Batch Job Entry

Transaction Description
Mode

RJE available Super Natural transactions may be submitted for batch mode execution if the Na ural
RJE facility is available at the user site. "Y" indicates that remote job entry is
available." N" indicates that remote job entry is not available, i.e. a transaction fo
batch execution may be created but not submitted. Default mode setting = N.

Service Generation Options

Option Description

Service Type Here you can define which service generation is allowed:
"N" No service generation is allowed.
"R" RPC Service is allowed.

Generation Mode Here you can define which generation mode is used.
"C" Context: A context area is defined where all data is stored. The client rear s the
data side by side. Thereby the 30K limit can be exceeded.
"D" Direct: All data sets are read out directly. If there are more result sets thar the
30K limit allows, you receive a hint for the further data

Library Type for Defines in which kind of library the service objects are stored.

Service Objects "S" Super Natural Library: The service object is stored in the same library as ' 1e
transaction and receives the same name as the transaction but with the prefi
defined for prototyping. It is not necessary to fill in the field Library Name.

"N" Specific Natural Library You have to specify the library name (in the field
Library Name for type N) where the service objects are stored. Here, the serv e
object name and the transaction name are identical.

"F "Free: The user can choose the library and object name without any restric ions.

Note:
Setting the library type is important to meet the requirements of the RPC logon feature that is set on the
client side. For further information see sect@neate Client Side Parameters

Display Options
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Description

Display
Occurrences
(MU)*

Display
Occurrences
(PE)*

Suppress
Empty Lines*

Suppress
Identical
Values*

Suppress Zero
Values*

Suppress
Numeric Sign*

Heading Width
Override*

Map Filling
Character*

Files

Here you can define which range of occurrences is to be displayed for a field de
as a multiple-value field. You can define a start value and an end value. Defaull
values=1.

The default number of occurrences to be displayed for a field contained within &

ined

periodic group. You can define a start value and an end value. Default value = . .

"Y" indicates that each empty line on a transaction report is to be suppressed.”
indicates that empty lines are not to be suppressed. Default value = N .

"Y" indicates that each identical line on a transaction report is to be suppressed
indicates that identical lines are not to be suppressed. Default value = N .

"Y" indicates that a value of zero for a field is to be suppressed on the transacti
report. "N" indicates that zero values are not to be suppressed. Default value =

"Y" indicates that the sign of a numeric field is to be suppressed on the transaci
report. "N" indicates that the signs of numeric fields are not to be suppressed. L
value =N .

"Y" indicates that Super Natural may truncate headers on the transaction repori
necessary to do so in order to prevent a line overflow condition. "N" indicates th
header truncation may not be performed. If "N" is specified, a screen appears w
the headers are too long where the action to be taken can be entered. Default \
N .

Characters chosen to differentiate between alphanumeric and numeric fields in
transactions generated for adding or updating data or for reporting using the De
Change mod®&APR Default value for alphanumeric fields = _ Default value for
numeric fields = .

When you chooseFiles , the Modify User >Files screen appears:
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Users

13:59 1999-05-21

SRMUMF

*rxxex Super Natural *****
- Modify User SBE >Files -
More: -+

Cmd File Name Access Password

SAG-TOURS-E-CH-PRICES R
SAG-TOURS-E-COMPANY R
SAG-TOURS-E-CONTRACT D
SAG-TOURS-E-CRUISE R
SAG-TOURS-E-PERSON R
SAG-TOURS-E-YACHT R
SUE-SUPER D

SUE1 D <
SUPER R
UF-SBE-NEW F <
UF-SBE-SAMPLE4 F

Add Add Multiple: _

>Options >Profile >Layout

Cmd(s): Add, Modify, Delete

File deleted from file list

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The Modify User Files screen displays the following:
® Files which the user can access

® Code for the data access level the user has for each file

e \Whether the user has an Adabas password for password protected files.

You use the Modify User >Files screen to link a user to (give him/her authorization to use) a file or to

modify or delete existing links.
Adding / Linking Single Files to a User
» To add (link) a single file to a user:

1. Issue thDDfile-namecommand.

wherefile-nameis the name of a file defined to Super Natural.

To obtain a selection list of files defined to Super Natural, usaddeMultiple File

The Add/Modify Link to File window appears:

function.

TEEZEXT SUPYRE HATURAL =%%xX 12230521

/13:59

— Heddify lgor FEE zTilox — FREHWMHE
(=218 Filo MAH #%—————————— —Rdd-Hzdify Tdrnk & Hlo————-——— —_
A
__  SRG-TOUR Tilo Tamm ..... SAG-TOURS-E—COMTRRCT____ ___ ___
_ SRG-TOUR
Hex  FRG-TOUER ! fecopzzx L. L. Ll D
__  FRAG-TOUER !
— TFRG=TOUER ! Fazzucrd ot ..
__  FRAG-ToUR ! Pazzecrd ...
__ SJJEZFUFL !
_ =i + +

N
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2. Determine the user’s access level to the file by typing one of the following codes in the Access field:

File Description

Access

Code

R Read only

U Update (includes read). The user can update existing records in this file. Not
available under Natural Security.

A Add (includes update). The user can add new records to this file. Not availablg under
Natural Security.

D Delete (includes add). The user can delete records in this file.

F If an F is entered in the Access field, the file is a user file created by the user you are
modifying. All data maintenance functions are available (read, add, update and
delete). For further information on user files, s=er Files

3. Enter a password in the Password field (optional).

Users who do not have the same password can not access transactions in public or common libraries
created by this user using this file.

For further information on passwords, &ser Profile, Option and Adabas Password Hierardhies
Technical Information.

4. Press Enter.

The user is now authorized to use the file at the access level specified.

Adding / Linking Multiple Files to a User

» To link multiple files to a user:

1. Mark the Add Multiple Files field on the Modify User >File screen.

The Add Multiple Files window appears:
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/—14102 WEERES FIFIRE HATURRL SAx&® 138 5=0S=-21 -\\

— Hsdify lzor SEE =Tilor — LZEHIHE
OHL TLl Fem e —AAA-Link Hutiplo FiloT———————————— —
x H Filn MaHOD fccorr Parrzusrd !
_ =ha -
. SRS ! SCONNECT _ e
RS ! AU-TILE
— e D seesurEs - L
__  TRG ! _ HAR _ e
—_ FHG ! - ARRAARAER - e
— UE ! _ HARRAAAAL _ e
. Jir _ HARAL _ e
—_ JIF ! - ARl - e
— uE— ! _ AR _ e
. r- _  hAE _ e
Ada _ AR _ e
- AT IWE=-TONES - e
=optiznz =Fr=filo
CHd | ] : Ald, Heddify, *Heozm! + +
Hark filoxr for functiocn ADDT HILTIFLE
2SHHANA ===
Entor-Frl-—-FfF2-—Fri>—--Fr4-—Fr=>=--Fff—-—Fr?——-Fr¥—-—Fra——--FF10—Frll —-Frl 3—-—

\ Holp Exit Ilip + canc -/

Mark each file you want to the user to be able to use.

Type in a file access code for each file.

For further information on file access codes, Adding / Linking Single Files to a Usar Users
Type in a password for each file (optional).

Press Enter.

The user is now authorized to use the files at the access levels specified.

Modifying Links to Files

You can maodify the access code and Adabas password for files the user is already authorized to use.

» To modify entries in the file list:

1.

Issue th&MODIFYfile-namecommand.
The Add/Modify Link to File window appears.
Modify the file access code (optional).

If the Password Set field is marked, a password is already defined for the file. You can either change
or delete the password.

Type a new password in the Password field to change the current password (optional).
Or:

Type blanks in the Password field to delete the current password (optional) and press Enter.
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The user is now authorized to use the file at the access level specified.
Deleting Links to Files

You can delete the link from a user to a file, the access code and Adabas password for files the user is
already authorized to use.

¥ To delete a file from the file list:
1. Issue th®ELETEfile-namecommand.
2. Confirm the deletion in the window which appears.

The user is no longer authorized to the file named.

Profile

When you chooseProfile  the Modify User >Profile screen appears:

14:02 *kkk Super Natural **++x 1999-05-21
- Modify User SBE >Profile - SRMUMP

_ Screen Colors

_ Screen Defaults

_ Date/Time Formats
_ PF-Key Settings

_ Checklist

>Options >Files >Layout

Mark function(s) or select by cursor

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

The User >Profile screen is a reduced version of the Modify Profile screen in the Super Natural Processor.
Screen Colors *

Determines the user’s default screen colors. On the left-hand side of the Screen Colors window there is a
list of the field types and screen areas which can be colored individually with their current color code
settings. The right-hand side shows a list of the colors available with their color codes.

If you mark the ‘Mark for Default’ field and press Enter, you return to the default settings supplied by
Software AG.
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Screen Defaults *
Message Line Position
Determines the message line position. There are three choices:
® |SA (above the command line)
® TOP (at top of the screen)
® BOT (at bottom of the screen)
Header Line Variables
Determines the position of the date, time, program name, object and day within the Super Natural header.
Hello Screen

TheHello screen is the screen which welcomes you to Super Natural. You can choose to switch this
screen off.

Default Entry Menu

Determines which of the following screens appears after the Hello screen when the user enters Super
Natural:

® Main Menu
® Transaction List screen
® Prototype Program List screen
® Model List screen
® Spreadsheet List screen
® Application List screen
® User File List screen.
Time and Date Formats *
Time Format

Determines how the date and time are displayed. You can choose to display the time either in 24 hour
format e.g. 17.30 or in am/pm format e.g. 5.30 pm.

Time Delimiter

Determines the time delimiter (the character which comes between the hours and the minutes when a time
is written). You can choose which character you want to use as the time delimiter.
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Date Format

Determines how the date is displayed. You can choose to display the date in any format you wish. The
following are some examples of dates in different formats and with different delimiters:

American MM/DD/YY
European DD/MM/YY
German DD.MM.YY
International YY-MM-DD
Date in format YYYYMMDD

PF Key Settings *

Determines th®F key display format. You can choose betwd8A format,SAAformat and action bar
format.

Checklist *

Determines whether the user is to useAhwmatic Checklist function by default and at which
level.

Layout

When you chooseLayout , the Profile Menu appears. You are now usingMoeify User
Profile  user-idpart of the product Natural Report Manager.

Note:
You can not issue tltROCcommand from Natural Report Manager.

» To specify the Layout
1. Mark Layout Options.
2. Press Enter.

The Layout Options: Screen Handling screen appears as in the following example:
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14:03 *** Natural REPORT MANAGER *** 1999-05-21
Layout - Modify User Profile SBE - NRMPROA
More: +

Layout Options: Screen Handling
Layout overview as default .................... X
Layout element literals on right side ......... X

Layout Element Sorting (Choose one)
No sorting decided ..............ccvveeee..
Manual sorting via command .................. _
Automatic sorting after every modification .. X

Layout Editor Screen State (Choose one)
Full screen without PF-Keys .................
Full screen with  PF-Keys ................. X

You are on the first page.

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Tech Canc

You can modify the following options:

Option Description

Layout If you mark this field, the Layout Overview screen is the first screen the us r
overview as will see when he invokes Natural Report Manager. If you leave this field bl ink,
default the Layout Editor (split screen) appears with all elements in the edit area.

Layout element If you mark this field, layout element literals (the Type column) appear on e

literals on right right-hand side of the Layout Editor edit area. If you leave this field blank,

side layout element literals (the Type column) appear on the left-hand side of tl 2
Layout Editor edit area.

Layout Element Sorting

» To specify the Layout Element Sorting

e Mark one of the following options:

Option Description

No sorting decided Layout elements are shown in the Layout Editor in the order they vere
defined. The elements appear in logical order when the reportis | In.

Manual sorting via The user can issue tBORTcommand to sort layout elements into

command logical order in the Layout Editor.

Automatic sorting after Layout elements are sorted into logical order in the Layout Editor
every modification when the user presses . Default Value: Automatic sorting
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Layout Editor Screen State

» To specify the Layout Editor Screen State

e Mark one of the following options:

Option Description
Full screen withoui When the user invokes the Layout Editor full screenPtRekey line is
PF keys replaced by two extra editor lines.
Full screen with  When the user invokes the Layout Editor full screenPtr&ey line is
PF keys displayed. Default Value: Full screen wiir keys

Delimiter

When you page forwards, the following screen appears:

14:03 *** Natural REPORT MANAGER *** 1999-05-21
Layout - Modify User Profile SBE - NRMPROC
More: -

Layout Options: Delimiter

Class  Attribut Color Delimiter

Text _ Default_ Blank
Text__ Intens._ _
Output__  Default_ (
Output__  Intens._ )

You are on the last page.
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Exit Flip - Tech Canc

You can create delimiters for the user to use in the Layout Editor using the following columns.

Column Description

Class The following classes are available Text Output Only

Attribute The following attributes are available: Italic/Cursive Normal (default) Intensified Not

displayed (for passwords etc) Underlined Reverse video Dynamic (not available)

Color The following colors are available: Blue Green Neutral Pink Red Turquoise Yellow

Delimiter Use special characters as delimiters to represent the combinations of class, attribute

colors you have specified.
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Modifying Multiple Users

TheModify Multiple Users function is available from the Special Servicesmenu. For further
information, sediodifying Multiple UserinSpecial Services

Copying Users
» To copy a user:
e |ssue theCOPY USERsource-user-id target-user-cbmmand.

A new user is created with the general options, file list, profile options and layout options of the
source user.

Deleting Users
» To delete a user:
1. Issue th®ELETE USERuser-idcommand.

2. Confirm the deletion in the window which appears.

Importing Users

When Super Natural is operating under theNatural Security system, you canmgatheser
function instead of thedd User function to define users.

The Import User function is listed on the Special Services menu. For further informationp@diag
Usersin Special Services
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Files

This section describes how to create and maintain file profiles.
This section covers the following topics:

® What are File Profiles?

® |isting File Profiles

® Adding Files

® Modifying Single Files

® Copying Files

® Deleting Files

® Importing Files

What are File Profiles?

File profiles consist of file option settings and a list of the users authorized to use the file.

You can add file profiles to Super Natural before the corresponding DDM or file in the database exists or
is linked toSuper Natural.

kACDIFY File

Dptions sars

For further information on option hierarchy, sé¢ger Profile, Option and Adabas Password
Hierarchies in Technical Information.

You can perform the following commands on file profiles:

ADD |MODIFY COPY |DELETE INFO |IMPORT MULTIMOD
File |X X X X X
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File Lists

Files

The File List in the Administration Application lists all the file profiles defined in Super Natural. No

checks are carried out to determine whether the Natural files and DDMs exist or not. All other lists of files
which you can invoke in the Super NaturalAdministration Application and the Super
NaturalPROCESSOR are subsets of this list. In some cases, only files which fulfil certain conditions are
displayed. The following diagram shows in which cases validity checks are carried out before a list of files

is displayed:

SUPER MATURAL Administration Application

Fie List
kAo ify Us=r Super- Us=rFie
HEH Files fie List List

Fie Se- Uz=rFie
lection List List

SUPER MNATURAL Processor

The following table describes which checks are carried out:

List Administration Files Displayed/Checks Performed Before Display

Application

[] =List checked before display

File List

Superfile List
Modify User xxx

>Files

User File List

All files, superfiles and user files defined in Super Natural (no checks).

All superfiles defined to Super Natural (no checks).

All files, superfiles and user files added to the Super Natural user specifiec (no

checks).

All user files which are defined in the current Personal Database. Super Ni tural
checks that there is a corresponding DDM for each user file in the current DIC.
Super Natural also checks that the directory record for each user file exists
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List Super Natural Processor Files Displayed/Checks Performed Before Display

User File List All the user’s own user files (file access code F).
Super Natural checks that the directory record for
each user file exists

File Selection List for Reporting Transactions 1. All the user’s own user files (file access code F,
(no checks).
2. All files and other user’s user files with file acce s
codes "R", "A", "U" and "D" (no checks).
3. All superfiles based on reporting transactions.
Super Natural checks that the superfile transactiol

exists.
File Selection List for Data Maintenance 1. All the user’s own user files (file access code" F )
Transactions: Transaction Typ®D: (no checks).

2. All files and other user’s user files with file acce s
codes "A" and "D".

3. All superfiles based on data maintenance
transactions with Transaction Typ®D

File Selection List for Data Maintenance 1. All the user’s own user files (file access code "F )
Transactions: Transaction Types (no UPDATE checks).
SINGLE/UPDATE MULTIPLE 2. All files and other user’s user files with file acce s

codes" A", "U" and "D".

3. All superfiles based on data maintenance
transactions with Transaction Typ@DATE
SINGLE or UPDATE MULTIPLE

File Selection List for Data Maintenance 1. All the user’s own user files (file access code "F ).
Transactions: Transaction TypELETE 2. All files and other user’s user files with file acce s
codes "D".

3. All superfiles based on data maintenance
transactions with Transaction TyP&ELETE

Listing File Profiles
» To obtain a list of files currently defined to Super Natural:
1. Issue th&ILE command.
Or:
Select the object File from the Administration Menu.

The File List screen appears as in the following example:
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14:31 *rxxk Super Natural ***** 1999-05-21
SBE - File List - SNMFL
More: +
Cmd File Name File Type
*

___ $CONNECT
A-U-FILE
AA-SUPER Superfile
AAA Superfile
AAAAAAAAA
AAAAAAAL Superfile
AAAL
AAL
AA2
AA8
AA9
ACTIVE-JOBS
___ ADMINISTRATION-FILE-DDM

Add
Cmd(s): Add, Modify, Copy, Delete
Select one command from list
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Exit Flip + Canc

The File List screen shows the following:

o Allfiles currently defined to Super Natural including DDMs, user files and superfiles.
The DDMs and the files on which they are based are not necessarily defined either in the
database or to Natural Security. Super Natural does not check this until a user adds a transaction
using the file.

e File type.
User files and superfiles are indicated in the File Type column.

Adding Files
» To add a file:

® |[ssue theADD FILE namecommand.

You can not add superfiles and user files.
The file is added (linked) to Super Natural. TheModify File > Options screen appears.

You can now set options and authorize users to use the file you have added. For further information, see
Modifying Single Files in Files.

Notes:

1. When you add (link) a file to Super Natural, the file has no option settings and no user list. If you
leave the options settings and/or the user list blank, the individual file settings which are part of each
user profile are valid for users when accessing this file. Otherwise, options set for a file in its file
profile override options set for it in a user profile. For further information on option hierarchy,
sedJser Profile, Option and Adabas Password Hierarchies Technical Information.

2. When you have finished modifying the file options and users, the file is added to the File List.

35



Files Super Natural Version 3.3.1 Administration

3. The DDM and the file on which it is based are not necessarily defined either in the database or to
Natural Security.Super Natural does not check this until a user adds a transaction using the file.
4. Users of Natural Security can also use the Import function to define file profiles.

Modifying Single Files
» To modify a single file:
® |ssue theODIFY FILE namecommand.

The Modify File >Options screen appears. You can either modify the file options or modify the user
list.

For information on navigating between profile setting groups>déavigationinintroduction .

Note:
Users must restart their Super Naturalsessions before your modifications are valid.
Your modifications are valid for all new transactions but not for existing ones.

Options

Note:
File options override user options. For further information on option hierarchyyseed’rofile, Option
and Adabas Password Hierarchiesn Technical Information.

» To specify Options
1. Choose-Options

The Modify File >Options screen appears.

14:32 *rrkk Super Natural ***** 1999-05-21
SBE Modify File SAG-TOURS-E-CONTRACT >Options SRMFMO

_ DDM Check / Display Options
_ Database Access

_ Exit Specification

_ VSAM Files

_ DL/1 Files

>Users

Mark function(s) or select by cursor

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc
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2. Mark the group(s) of options you want to modify and press Enter

3. Overtype the options you want to maodify if you are modifying a file.

Or:

Type settings if you are adding a file and press Enter

You modifications/entries are saved.
You can modify the options listed in the following sections.

DDM Check / Display Options

Option

Description

DDM Check on
Modify

Prefix for Inverse
Field Output

Display
Occurrences
(Multiple Value
Field)

Display
Occurrences
(Periodic Group)

Suppress Numeric
Sign

Run Modes
Available

Database Access

"Y"indicates that each time aSuper Natural-transaction is modified, a check s
made to see if the transaction is still consistent with the data definition modt e
(DDM) for the file or files involved. A warning is issued when a user modifie: a
transaction if the DDM has been changed.

"N"indicates that no check is to be made. Any changes made to the DDM si ce
the transaction was created/last modified are ignored. The default is N.

Prefix used for files with both fields in regular and inverse formatSGeer
Natural in Inverse Mode in Setting UpSuper Naturalin theSuper Natural
Installation documentationThe default value is blank.

The default number of occurrences (i.e. values) that are to be displayed for . field
defined as a multiple value field. The default setting is 1.

The default number of occurrences that are to be displayed for a field conta 1ed
within a periodic group. The default setting is 1.

"Y"indicates that the sign of a numeric field is to be suppressed on the trans ction
report.

"N" indicates that the signs of numeric fields are not to be suppressed. The efault
setting is N.

ONLINErun mode allows users to access the file online.
BATCHun mode allows users to access the file in batch operation.
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Description

Physical Read
Allowed

Non-Descriptor
Criteria Allowed

Maximum Number of
Criteria

Display Values For
Key Fields Allowed

Adabas Sorting
Allowed

Buffer/External
Sorting Allowed

Maximum Number of
Records

Adabas Password

Adabas Cipher Code

Exit Specification
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"Y"indicates that a physical read of an entire file is allowed in the case of 1
transaction in which the selection criteria specified requires such.
"N"indicates that a physical read of an entire file is not allowed. The defai It
setting is Y. This option allows separate settings for online and batch run
mode. This option must be "N" f@L/ 1files.

"Y" indicates that a transaction may use selection criteria that contain
non-descriptors, i.e., fields that have not been defined as key fields.

"N" indicates that the transaction may only use selection criteria comprise 1 of
key fields. The default setting is Y. This option allows separate settings fc -
online and batch run mode.

The maximum number of criteria permitted within a transaction. The defa It
setting is 99. This option allows separate settings for online and batch rui
mode.

"Y" indicates that users can use the Values for Key Fields function on this file.
"N"indicates that the user may not use the Values for Key Fields function
Default value = N .

"Y"indicates that theAdabas internal sort feature may be used for a transi ction
that contains sort criteria comprised of one to three key fields.

"N"indicates that theAdabas internal sort feature may not be used. The d fault
setting is Y. This option allows separate settings for online and batch run
mode. This option must be"N"fDL/ | files.

"Y" indicates that a buffer or external sort feature may be used.

"N" indicates that a buffer or external sort feature may not be used. The ¢ :fault
setting is Y. This option allows separate settings for online and batch run
mode.

The maximum number of records that may be processed for a transactiol . The
default setting is 999999. This option allows separate settings for online ¢ 1d
batch run mode.

If anAdabas file that is security protected is to be available to Super Natu 2
transactions, the password for the file must be provided. Seéelgimas
Security documentatidior additional information onAdabas security.

If anAdabas file that is ciphered is to be available toSuper Naturaltransac ons,
the cipher code for the file must be provided. Sed\ttabas Security
documentatiorior additional information onAdabas ciphering.
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Option Description

Exit Module Specify the name of the external program to be activated. The program must e
Program 1D accessible via a Natu@ALL orCALLNATtatement.

Use Natural Mark this field if the user exit program is a Natural object.

Object

Exit Location Defines when the exit routine is to be executed. The available options are list¢ 1 on
the screen. Enter the appropriate number.

The exit module specifications made as file options are used as default values when the file is accessed.
Users can override the default values using the Exit Specification function described in the Jssstion
Exits in theSuper NaturalUser’s Guide

Note:
If the exit program requires parameters, the user must specify them manually u&riy the
Specification function.

For further information on user exits, 98¢t Programs.
VSAM Files

Note:
You can not use the transaction mode for data mainted&@iz&TE MULTIPLEwithVSAMfiles.

Option Description

Record Type Name of the field on which the record type is based.
Field Name

Record Type Format of the record type."A" - alphanumeric, "N" - numeric,"B" - binary.
Format

Record Type Length of the record type (1 to 10).
Length

Record Type Number of positions in the record type base field prior to the record type value. Fc
Offset example, if the record type being defined is located in the third position of the bas: field,
the value 2 would be entered as offset to skip the first two positions.

Record Type Value of the record type.
Value

Record Type End value, if the record type is to cover a range of values (optional).
End Value

Example:

Record type field name CRUISE-IDIs record type a key?Record type format NRecord type length 1Record type offset 1Record type value 3Record type end value 5

If a transaction is created using the user view as defined above, only those records of the physical file will
be available that have the numbers 3, 4 or 5 (value/end value) as second character (offset) of the
fieldCRUISE-ID.
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DL/1File Options (DL/1Considerations)

Note:
The file options Physical Read AllowedandAdabas Sorting Allowed must be set to'DI/fbfiles.

The following window is displayed:

14:32 *kkx Super Natural **+*x 1999-05-21
SBE Modify File SAG-TOURS-E-CONTRACT >Options SRMFMO
Fommom - DL/1 Files--------------- +

! File: SAG-TOURS-E-CONTRACT !
! !
_ DDM Check / Display O ! !
! Enter up to 5 PSBs where this file is !
_ Database Access lincluded. !
! !
_ Exit Specification ! 1 .. !

12 !
_ VSAM Files 3. !
4. !
_ DL/1 Files I'5.. !
! !

| (DL/1 only) !
!

+ +
t 1

The PSB entry is used for (A TPSBcommand when running a transaction agaibst/a file.
If only one file is accessed in the transaction, the firstPSBentry will always be used.

If two files have been linked for the transaction, thePSB lists of these files are compared to find a
commonPSB for the linked files.

Note:
This option is only valid when operating under CICS.

Users

When you chooseUsers , theModify File >Users screen appears as in the following example:
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14:33 *rxxex Super Natural ***** 1999-05-21
SBE - Modify File SAG-TOURS-E-CONTRACT >Users - SRMFMU
More: +

Cmd User ID Access Password

_AZ R
__BF R
__ CCA R
__CcCH R
__CF D
__CHEF D
__CMR D
__CR R
__ DA R
__DEMO1 R
__DEMO2 R
Add Add Multiple: _

>Options

Cmd(s): Add, Modify, Delete

Select one command from list

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The Modify File >Users screen displays the following information:
® Users which are authorized to use the file you are modifying
® Code for the data access level the user has for each file
e \Whether the user has an Adabas password for password protected files.

You use the Modify File >Users screen to link users to (give him/her authorization to use) to the file you
are modifying/adding or to modify or delete existing links.

If you are adding a file, the Modify File>Usersscreen is empty.
Adding / Linking Single Users to a File
» To add (link) a user to a file:

1. Issue thdDD USERamecommand.

The Add/Modify Link to User window appears:
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14:34 *rxxk Super Natural ***** 1999-05-21
SBE - Modify File SAG-TOURS-E-CONTRACT >Users - SRMFMU

Cmd User ID Access Password +--Add/Modify Link to User--+
|

* |

__AZ R I User D ....... CF !
___BF R ! !

__CCA R I Access ........ D !
__CCH R ! !

mo CF D I Password set .. !

__ CHEF D I Password ...... !
__CMR D ! !

__CR R + +

2. Determine the user’s access level to the file by typing one of the following codes in the Access field:

File Access |Description

Code

R Read only

U Update (includes read). The user can update existing records in this file. Npt
available under Natural Security.

A Add (includes update). The user can add new records to this file. Not avail@ble
under Natural Security.

D Delete (includes add). The user can delete records in this file.

3. Enter a password in thePassword field (optional).

Users who do not have the same password can not access transactions in public or common libraries
created by this user using this file.

4. Press Enter.

The user is now authorized to use the file at the access level specified.
For further information on passwords, &éser Profile, Option and Adabas Password
HierarchiesinTechnical Information.

Adding / Linking Multiple Users to a File

» To link multiple users to a file:
1. Mark the Add Multiple field on theModify File >User screen.

The Add/Link Multiple Users window appears:
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Files

14:34 *rxxk Super Natural ***** 1999-05-21
SBE - Modify File SAG-TOURS-E-CONTRACT >Users - SRMFMU
Cmd User ID Access Password +----Add/Link Multiple Users----+
* I UserID Access Password !
AZ R Io* !
BF R | *kkkkkk |
__CCA R A _ !
__CCH R I AA _ !
__CF D I AAl _ !
___ CHEF D 1 AA2 _ !
__CMR D I AA3 _ !
__CR R I AA4 _ !
__ DA R I AA5 _ !
__ DEMO1 R I AA6 _ !
__ DEMO2 R I AA7 _ !
Add Add Multiple: x ! _ AA8 _ !
I AA9 !
>Options ! !
Cmd(s): Add, Modify, Delete +More:  H----mmmmmmm e +

2. Mark each user you want to use the file.

3. Type in a file access code for each user.

For further information on file access codes, Adding / Linking Single Users to a Filein Users

4. Type in a password for each file (optional).

5. Press Enter.

The users are now authorized to use the file at the access levels specified.

Modifying Links to Users

You can modify the access code and Adabas password for users already authorized to use the file.

» To modify a link to a user:
1. Issue théMODIFYusecommand.
The Add/Modify Link to User window appears.

2. Modify the file access code (optional).

If the Password Set field is marked, a password is already defined for the file. You can either change

or delete the password.

3. Type a new password in the Password field to change the current password (optional).

Or:

Type blanks in the Password field to delete the current password (optional) and press Enter.
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The user is now authorized to use the file at the access level specified.

Deleting Links to Users

You can delete the link from the file to a user, the access code andAdabaspassword for files the user is
already authorized to use.

¥ To delete a file from the file list:
1. Issue th®ELETRIser-idcommand.
2. Confirm the deletion in the window which appears.

The user named is no longer authorized to the file.

Copying Files
» To copy a file:
® |ssue theCOPY FILE source file-name target file-name command

A new file is created with the file options and user list of the source file.

Deleting Files
¥ To delete afile:
1. Issue th®ELETE FILE file-namecommand.

2. Confirm the deletion in the window which appears.

Importing Files

When Super Natural is operating under theNatural Security system, you canmgethEile
function instead of thedd File  function to define files.

The Import File function is listed on the Special Services menu. For further informatiémpsegng
FilesinSpecial Services
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Superfiles

This section covers the following topics:
® \What are Superfiles?
® \What are Superfile Profiles?
® Listing Superfiles
® Adding Superfiles
e Modifying Superfiles

e Deleting Superfiles

What are Superfiles?

Superfiles are transactions stored as files. Superfiles are transactions created by the administrator which
the user can access from theSuperfile Selection List window.

Superfiles reside in a Super Natural library. The name of this library is composed of the prefix for public
libraries in the administrator’s user profile (default "Z") together with the text string SUPFILE:

administrator’s-public-library- prefixSUPFILE

Note:
Only users which have the same public library prefix as the administrator can use superfiles.

You can use the following commands with the object Superfile:

ADD |MODIFY COPY |DELETE |INFO |IMPORT |MULTIMOD

Superfile | X X X X

User Views

You can use superfiles to create logical database views which means that you can limit user access to
certain data. For example, you may want users to be able to access certain fields from two files, but not all
the fields from both files. You can create a transaction linking the two files, and remove the fields you
don’t want the users to see. By creating a superfile from the transaction and allowing users to access the
superfile but not the original files, you can achieve a degree of data security.

Transaction Templates

You can use superfiles as transaction templates which users can use as a basis for their own transactions.
You can create a transaction in which files are already linked and complicated or lengthy selection

criteria, logical condition processing statements or calculation statements are already entered, thus saving
the user time and trouble.
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Superfiles which a user is authorized to use appear in the File Selection List window marked with the file
access code you defined. Only the superfiles which are applicable to the transaction type selected are
displayed. When a user selects a superfile, it is made available to him for modification and subsequent
execution as follows:

What Users Can Modify in a Superfile
A superfile provides a basis for a transaction, but users can change the following:
e Sort and control fields
® Display fields
e System functions
® Selection criteria
e SQL
® [ogical conditions
e Calculations
Modifications which users make to a superfile are only valid for the user transaction they are made in.
What Users Cannot Modify in a Superfile

Users can not modify the fields and the files used in the superfile for their own transaction. Consequently,
fields suppressed in a superfile will not be available to the user.

Only the Super Natural administrator can change superfile file specifications.

What are Superfile Profiles?

Superfile profiles consist of file option settings and a list of the users authorized to use the file.

RAQDIFY Superfile

Cption s sers

Note:
Superfile options override user options.
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For further information on option hierarchy, déser Profile, Option and Adabas Password
Hierarchies in Technical Information.

Listing Superfiles
» To obtain a list of existing superfiles:
® [ssue theSUPERFILE command.
Or:
Select the object "Superfile" from theAdministration Menu.

The Superfile List screen appears:

14:37 ek Super Natural **x+* 1999-05-21
SBE - Superfile List - SNMSL
More: -+
Cmd Superfile Name
*

SPES-UP
SUE-SUPER
SUP-AAA
SUP-CCC
SUP-HALLO
SUP-REP
SUPER
SUPER-FILE-DEUF
SUPER-FILE-DREI
SUPER-FILE-EINS
SUPER-FILE-SQL
SUPER-FILE-UFIL
___ SUPER-FILE-WFILE
Add
Cmd(s): Add, Modify, Copy, Delete
Select one command from list
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

Adding Superfiles

» To add a superfile:
1. Add and save the transaction you want to be the basis of your superfile.
2. Invoke the Superfile List screen as described in the previous section.
3. Issue thé\DD SUPERFILEnamecommand.

The name can be a 1-32 character value and does not need to be the same as the transaction ID.
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The Add Superfile window appears:

14:37 *Rkk Super Natural ***** 1999-05-21
SBE - Superfile List - SNMSL
More: -+
Cmd Superfile Name Fommemmeee Add Superfile------------ +
* ! !
__ SPES-UP ! Superfile name !
__ SUE-SUPER I SUPER-NEW !
__ SUP-AAA ! !
__ Sup-CcC I Copy from program: !
__ SUP-HALLO ! !
__ SUP-REP I Library prefix .. P !
__ SUPER I Library name .... !
__ SUPER-FILE-DEUF ! !
__ SUPER-FILE-DREI I Program prefix .. | !
__ SUPER-FILE-EINS ! Program name .... !
__ SUPER-FILE-SQL ! !
__ SUPER-FILE-UFIL + +

4. Type the prefix of the library in which the transaction is stored in theLibrary Prefix field.
5. Type the name of the library in which the transaction is stored in theLibrary Name field.
6. Type the program prefix of the transaction in the Program Prefix field.

7. Type the ID of the transaction in the Program Namefield.

8. Press Enter.

The Modify Superfile >Options screen appears. You can now set options and authorize users to use
the file you have added. For further information, Beaifying Superfiles.

» To modify a superfile:
® |ssue theViODIFY SUPERFILEnamecommand.

The Modify Superfile >Options screen appears:
You can either modify the file options or modify the user list.

For information on navigating between profile setting group$aeigating Between Profile Setting
Groups in Introduction.

Note:
Users must restart their Super Naturalsessions before your modifications are valid.
Your modifications are valid for all new transactions but not for existing ones.

Options
Note:

Superfile options override user options. For further information on option hierarchyseseProfile,
Option and Adabas Password Hierarchie§ echnical Information.
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» To specify Options

1. Choose-Options , the Modify Superfile >Options screen appears.

18:43 *rxeek Super Natural **x+* 1999-05-16
- Modify File BBFILE >Options - SRMFMO

_ DDM Check / Display Options
_ Database Access

_ Replace Superfile Specification

>Users

Mark function(s) or select by cursor

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

2. Mark the group(s) of options you want to modify.
3. Press Enter.
4. Overtype the options you want to modify if you are modifying a superfile.
Or:
Type settings if you are adding a superfile and press Enter.
You modifications/entries are saved.
Note:
When you add a superfile the file has no option settings and no user list. The individual file settings which
are part of each user profile are valid for users when accessing this superfile if you leave the options

settings and/or the user list blank. Otherwise, options set for a superfile in its superfile profile override
options set for a it in a user profile.

You can maodify the following options:

DDM Check / Display Options
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Description

DDM Checking on
Modify

Prefix for Inverse
Field Output

Display
Occurrences
(Multiple Value
Field)

Display
Occurrences
(Periodic Group)

Suppress Numeric
Sign

Run Modes
Available

Database Access
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"Y"indicates that each time aSuper Natural-transaction is modified, a check s
made to see if the transaction is still consistent with the data definition modt e
(DDM) for the file or files involved. A warning is issued when a user modifie: a
transaction if the DDM has been changed.

"N"indicates that no check is to be made. Any changes made to the DDM si ce
the transaction was created/last modified are ignored. The default is N.

Prefix used for files with both fields in regular and inverse formatSGeer
Natural in Inverse Mode in Setting Up Super Naturalin theSuper Natural
Installation documentatianThe default value is blank .

The default number of occurrences (i.e. values) that are to be displayed for . field
defined as a multiple value field. The default settingis 1.

The default number of occurrences that are to be displayed for a field conta 1ed
within a periodic group. The default setting is 1 .

"Y"indicates that the sign of a numeric field is to be suppressed on the trans ction
report.

"N"indicates that the signs of numeric fields are not to be suppressed. The ¢ >fault
setting is N .

"ONLINE"run mode allows users to access the file online.
"BATCH" run mode allows users to access the file in batch operation.
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Option Description
Physical Read "Y"indicates that a physical read of an entire file is allowed in the case of a
Allowed transaction in which the selection criteria specified requires such.

"N"indicates that a physical read of an entire file is not allowed. The defaull
setting is Y . This option allows separate settings for online and batch run r ode.
This option must be "N" fobL/ I files.

Non-Descriptor "Y" indicates that a transaction may use selection criteria that contain

Criteria Allowed non-descriptors, i.e., fields that have not been defined as key fields.
"N" indicates that the transaction may only use selection criteria comprised >f
key fields. The default setting is Y . This option allows separate settings for
online and batch run mode.

Maximum Number The maximum number of criteria permitted within a transaction . The defau :

of Criteria setting is 99 . This option allows separate settings for online and batch run node.
Adabas Sorting "Y"indicates that theAdabas internal sort feature may be used for a transac ion
Allowed that contains sort criteria comprised of one to three key fields.

"N"indicates that the Adabas internal sort feature may not be used. The de ult
setting is Y . This option allows separate settings for online and batch run r ode.
This option must be"N" fobL/ | files.

Buffer/External "Y" indicates that a buffer or external sort feature may be used.
Sorting Allowed "N"indicates that a buffer or external sort feature may not be used. The def ult
setting is Y . This option allows separate settings for online and batch run r ode.

Adabas Password If anAdabas file that is security protected is to be available to Super Nature
transactions, the password for the file must be provided. Séeltims Security
documentatiorior additional information onAdabas security.

Adabas Cipher Cod If anAdabas file that is ciphered is to be available toSuper Naturaltransactic 1s,
the cipher code for the file must be provided. Sed\ttebas Security
documentatiorior additional information onAdabas ciphering.

Replace Superfile Specification

You use thdReplace Superfile Specification function to update the current superfile if you
have modified the transaction it uses. Replace Superfile Specification function replaces
the transaction on which the superfile is based with the transaction you specify.

When you choose thHeeplace Superfile Specification function, the Replace Superfile
Specification window appears:
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14:12 *rrkk Super Natural ***** 1995-05-17
- Modify File CF-SUPER >Options - SRMFMO

+-Replace Superfile Specification--+
! !
! Superfile name !
_ DDM Check / Display Option! CF-SUPER !
! !
_ Database Access I Copy from program: !
! !
_ Replace Superfile Specific! Library prefix .. E !
I Library name .... !
! !
I Program prefix .. | !
!
!

Program name .... !
]
+ +

» To replace the superfile transaction specification:

1. In the Library Prefix field, type the prefix of the library which contains the transaction with which
you want to replace the current superfile specification.

2. In the Library Name field, type the name of the library which contains the transaction with which you
want to replace the current superfile specification.

3. In the Program Prefix field, type the program prefix of the transaction with which you want to
replace the current superfile specification.

4. In the Program Name field, type the name of the transaction with which you want to replace the
current superfile specification.

5. Press Enter.

Note:
Existing transactions which use the old version of the superfile are not affectedRppthee
Superfile Specification function.

Users

When you chooseUsers , theModify Superfile >Users screen appears as in the following example:
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14:39 *ekk Super Natural **+* 1999-05-21
SBE - Modify File SUPER-FILE-SQL >Users - SRMFMU

Cmd User  Access Password
*

___CF R

__KE R

Add Add Multiple: _

>Options

Cmd(s): Add, Modify, Delete

Select one command from list

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The Modify Superfile >Users screen displays the following information:
® Users which are authorized to use the superfile you are modifying
® Code for the data access level the user has for each superfile
e \Whether the user has an Adabas password for password protected superfiles.

You use the Modify Superfile >Usersscreen to link users to (authorize them to use) the superfile you are
modifying/adding or to modify or delete existing links.

If you are adding a superfile, theSuperfile>Users screen is empty.
Adding / Linking Single Users to a Superfile
» To add (link) a user to a superfile:

1. Issue thdDD USERamecommand.

The Add/Modify Link to User window appears:
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Superfiles
14:39 wERx Super Natural 1999-05-21
SBE - Modify File SUPER-FILE-SQL >Users - SRMFMU

Cmd User  Access Password +--Add/Modify Link to User--+
* |

__ CF R I User D ....... KE !

mo KE R ! !
I Access ........ R !

|

! !

I Password set .. !
I Password ...... !
|

2. Determine the user’s access level to the superfile by typing one of the following codes in the Access

field:
File Access |Description
Code
R Read only
U Update (includes read). The user can update existing records in this file. Npt
available underNatural Security.
A Add (includes update). The user can add new records to this file. Not avail@ble
underNatural Security.
D Delete (includes add). The user can delete records in this file.

3. Enter a password in thePassword field (optional).

Users who do not have the same password can not access transactions in public or common libraries
created by this user using this superfile.

For further information on passwords, &¢ser Profile, Option and Adabas Password Hierarchies
in Technical Information.

4. Press Enter.

The user is now authorized to use the superfile at the access level specified.

Adding / Linking Multiple Users to a Superfile

» To link multiple users to a superfile:

1. Mark the Add Multiple field on theModify Superfile >User screen.

The Add/Link Multiple Users window appears:
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14:39 **kk% Super Natural ***** 1999-05-21
SBE - Modify File SUPER-FILE-SQL >Users - SRMFMU
Cmd User  Access Password +----Add/Link Multiple Users----+
* I UserID Access Password !
CF R [ !
KE R | *kkkkkk |
- A - !
- I AA !
. I AAl !
. I AA2 !
. I AA3 !
. I AA4 !
. I _AA5 !
. I AA6 !
. I AA7 !
Add Add Multiple:c ! _ AA8 _ !
! AA9 !
>Options ! !
Cmd(s): Add, Modify, Delete +More:  H----mmmmmmm e +
Mark users for function ADD MULTIPLE

2. Mark each user you want to use the superfile.
3. Type in a superfile access code for each user.

For further information on superfile access codesidéding / Linking Single Users to a Superfile
in Superfiles

4. Type in a password for each superfile (optional).
5. Press Enter.
The users are now authorized to use the superfile at the access levels specified.
Modifying Links to Users
You can modify the access code and Adabaspassword for users already authorized to use the superfile.
» To modify a link to a user:
1. Issue th&1ODIFYusecommand.
The Add/Modify Link to User window appears.
2. Modify the superfile access code (optional).

If the Password Set field is marked, a password is already defined for the superfile. You can either
change or delete the password.

3. Type a new password in the Password field to change the current password (optional).
Or:

Type blanks in the Password field to delete the current password (optional) and press Enter.
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The user is now authorized to use the superfile at the access level specified.
Deleting Links to Users

You can delete the link from the superfile to a user, the access code andAdabas password for superfiles
the user is already authorized to use.

» To delete a superfile from the superfile list:
1. Issue th®ELETHRIser-idcommand.
2. Confirm the deletion in the window which appears.

The user named is no longer authorized to the superfile.

Deleting Superfiles

» To delete a superfile:
1. Issue th®ELETE SUPERFILEsuperfile-nameommand.

2. Confirm the deletion in the window which appears.
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User Files

This section describes user files and covers the following topics:
This section covers the following topics:

® \What are User Files?

What are User File Profiles?

Listing User Files

Modifying User Files

Deleting User Files

What are User Files?

User files are created by users and are stored in the personal database. The personal database consists of
one or more physicalAdabas files. Each user works on one file which is determined in his profile.

The user ID of the user who created it is part of each user file name. The user ID is checked each time a
transaction using a user file or with Destination USERFILE is run from a private library to make sure it is
the same as the private library ID.

For further technical information on user files, Begsonal Databasm Technical Information.

You can use the following commands with the object User File:

ADD |MODIFY COPY |DELETE INFO |IMPORT MULTIMOD
User File X X

What are User File Profiles?

User File profiles consist of file option settings and a list of the users authorized to use the file.

RAODIFY U=er Fik

Cption s sers
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Note:
User File options override user options.

For further information on option hierarchy, déger Profile, Option and Adabas Password
Hierarchies in Technical Information.

Listing User Files

» To obtain a list of existing user files:

Issue thaJSERFILE command.
Or:
Select the object User File from theAdministration Menu.

The User File List screen appears:

14:43 *rxxx Super Natural ***** 1999-05-21
SBE - User File List - SNMDL
More: -+

Cmd User File Name DB FNO

___ UF-HAH-A21

__ UF-HAH-A22 10 90

__ UF-HAH-A23 10 90

___ UF-HAH-A24 10 90

__ UF-HAH-A26 10 90

___ UF-HAH-A27 10 90

__ UF-HAH-A28 10 90

__ UF-HAH-A29 10 90

__ UF-HAH-A3 90

__ UF-HAH-A30 10 90

___ UF-HAH-A31 10 90

__ UF-HAH-A32 10 90

__ UF-HAH-A33 10 90
Cmd(s): Modify, Delete
Select one command from list
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Exit Flip + Canc

Modifying User Files

» To modify a user file:
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For information on navigating between profile setting groups>Bleigationin Introduction .

Note:
Users must restart their Super Naturalsessions before your modifications are valid. Your
modifications are valid for all new transactions but not for existing ones.

Options
User file options override user options.

For further information on option hierarchy, déser Profile, Option and Adabas Password
Hierarchies in Technical Information.

» To specify the Options

1. ChooseOptions , the Modify User File >Options screen appears:

14:44 kR Super Natural ***** 1999-05-21
SBE - Modify File UF-HAH-A23 >Options - SRMFMO
_ Display Options

_ Database Access

_ User File Expiration Date

>Users

Mark function(s) or select by cursor

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

2. Mark the group(s) of options you want to modify.

3. Press Enter.

4. Overtype the options you want to modify if you are modifying a user file.
OR

5. Type settings if you are adding a user file.

6. Press Enter.
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You modifications/entries are saved.

When you link a user to a user, file the file has no option settings and no user list. The individual file
settings which are part of each user profile are valid for users when accessing this user file if you leave the
options settings and/or the user list blank. Otherwise, options set for a user file in its user file profile
override options set for it in a user profile.

You can modify the following options:

Display Options

Option Description

Prefix for Inverse Prefix used for files with both fields in regular and inverse formatSGeer
Field Output Natural in Inverse Mode in Setting Up Super Naturalin theSuper Natural
Installation documentatianThe default value is blank .

Display Occurrences The default number of occurrences (i.e. values) that are to be displayed f r a
(Multiple Value Field) field defined as a multiple value field. The default setting is 1.

Display Occurrences The default number of occurrences that are to be displayed for a field cor ained
(Periodic Group) within a periodic group. The default setting is 1.

Suppress Numeric  "Y" indicates that the sign of a numeric field is to be suppressed on the
Sign transaction report.

"N"indicates that the signs of numeric fields are not to be suppressed. Th
default setting is N.

Run Modes Available "ONLINE" run mode allows users to access the file online. "BATCH" run
mode allows users to access the file in batch operation.

Database Access
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Option Description
Physical Read "Y" indicates that a physical read of an entire file is allowed in the case of ¢
Allowed transaction in which the selection criteria specified requires such.

"N"indicates that a physical read of an entire file is not allowed. The defaul
setting is Y. This option allows separate settings for online and batch run n >de.
This option must be "N" fobL/ I files.

Non-Descriptor "Y" indicates that a transaction may use selection criteria that contain

Criteria Allowed non-descriptors, i.e., fields that have not been defined as key fields.
"N" indicates that the transaction may only use selection criteria comprisec of
key fields. The default setting is Y . This option allows separate settings fol
online and batch run mode.

Maximum Number The maximum number of criteria permitted within a transaction . The defat

of Criteria setting is 99 . This option allows separate settings for online and batch run node.
Adabas Sorting "Y" indicates that the Adabas internal sort feature may be used for a transe :tion
Allowed that contains sort criteria comprised of one to three key fields.

"N"indicates that the Adabas internal sort feature may not be used. The de ault
setting is Y . This option allows separate settings for online and batch run 1 ode.
This option must be"N"fdL/ | files.

Buffer/External "Y" indicates that a buffer or external sort feature may be used.
Sorting Allowed "N" indicates that a buffer or external sort feature may not be used. The de ault
setting is Y . This option allows separate settings for online and batch run r ode.

Adabas Password If anAdabas file that is security protected is to be available to Super Nature
transactions, the password for the file must be provided. Séeltims Securit
documentatiorfor additional information onAdabas security.

Adabas Cipher Cod: If anAdabas file that is ciphered is to be available toSuper Natural transact ins,
the cipher code for the file must be provided. Sed\ttebas Security
documentatiorior additional information onAdabas ciphering.

User File Expiration Date

The User File Expiration Date window contains the following information about the user file:
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Information  Description

User File The name of the user file as assigned by the user.

Name

User File Physical ID of the Adabas database used to store the user fildg@eEile Adabas
DBID Database IDin User profile).

User File Number of the Adabas file used to store the user filesl{seeFile Adabas File
Number Number in User profile).

User ID of the user who created the user file.

Description  Three-line description entered by user creating the file.

Created "on:" Date of creation "at : "Time of creation

Status Status of the file as follows:"IN USE" Field definitions (and possibly data) exist fo this

file "DATA DEL" Field definitions exist. Data has been cleared "FILE DEL" File hi s
been deleted logically but can still be retrieved ******** Deletion currently in proce ;s.

Record Count Number of records contained in the file.
You can set an expiration date for the file.

Option Description

Expiration Date Type the file expiration date in the format YYYY-MM-DI .

Users

When you chooseUsers , the Modify User File >Users screen appears as in the following example:

14:44 *rxeek Super Natural **** 1999-05-21
SBE - Modify File UF-HAH-A23 >Users - SRMFMU
More: -
Cmd User  Access Password
*

__AAl R

__ AA2 D

___ AA3 U

__ AA4 R <

Add Add Multiple: _
>Options
Cmd(s): Add, Modify, Delete
Link to User modified
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Exit Flip + Canc
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The Modify User File >Users screen displays the following information:
® Users which are authorized to use the user file you are modifying
e Code for the data access level the user has for each
® Whether the user has an Adabas password for password protected user files.

You use the Modify User File >Users screen to link users to (authorize them to use) the user file you are
modifying/adding or to modify or delete existing links.

If you are adding a user file, the User File>Users screen is empty.
Adding / Linking Single Users to a User File
» To add (link) a user to a user file:

1. Issue thDD USERnamecommand.

The Add/Modify Link to User window appears:

11:35 ek Super Natural **v 1999-05-24
- Modify File UF-HAH-A23 >Users - SRMFMU

Cmd User Access Password +--Add/Modify Link to User--+
!

* |

I User D ....... SBE !

__ AAl R

_ AA2 D ! !

__ AA3 U I Access ........ _ !

__ AA4 R < ! !

_ I Password set .. !

_ I Password ...... !
! I
+ +

2. Determine the user’s access level to the user file by typing one of the following codes in the Access
field:

File Access |Description

Code

R Read only

U Update (includes read). The user can update existing records in this file. Njot
available underNatural Security.

A Add (includes update). The user can add new records to this file. Not availgble
underNatural Security.

D Delete (includes add). The user can delete records in this file.

F Indicates that the user created the file.

3. Enter a password in thePassword field (optional).
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Users who do not have the same password can not access transactions in public or common libraries
created by this user using this user file.

For further information on passwords, &¢ser Profile, Option and Adabas Password Hierarchies
in Technical Information.

4. Press Enter.
The user is now authorized to use the user file at the access level specified.
Adding / Linking Multiple Users to a User File
» To link multiple users to a user file:
1. Mark the Add Multiple field on theModify User File >User screen.

The Add/Link Multiple Users window appears:

14:46 *rrkk Super Natural ***** 1999-05-21
SBE - Modify File UF-HAH-A23 >Users - SRMFMU
Cmd User  Access Password +----Add/Link Multiple Users----+
* I UserID Access Password !
___AAl1 R Io* !
AA2 D | *kkkkkk |
__AA3 U LA _ !
_ AA4 R < 1 _AA _ !
! AAb !
- | AA6 !
- | AA7 !
- | _ AA8 !
- I AA9 !
. I AA91 !
. I AA92 !
Add Add Multiple: _ ! _ AA93 _ !
I AA94 !
>Options ! !
Cmd(s): Add, Modify, Delete +More:  +---mm-memmm e +

2. Mark each user you want to use the user file.
3. Type in a user file access code for each user.

For further information on user file access codesAsiing / Linking Single Users to a User File
in User Files

4. Type in a password for each user file (optional).
5. Press Enter.

The users are now authorized to use the user file at the access levels specified.
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Modifying Links to Users
You can modify the access code and Adabas password for users already authorized to use the user file.
» To modify a link to a user:
1. Issue th&1ODIFYusercommand.
The Add/Modify Link to User window appears.
2. Modify the user file access code (optional).

If the Password Set field is marked, a password is already defined for the user file. You can either
change or delete the password.

3. Type a new password in the Password field to change the current password (optional).
Or:
Type blanks in the Password field to delete the current password (optional) and press Enter.
The user is now authorized to use the user file at the access level specified.
Deleting Links to Users

You can delete the link from the user file to a user, the access code andAdabas password for user files the
user is already authorized to use.

¥ To delete a user file from the user file list:
1. Issue th®ELETEuser-idcommand.
2. Confirm the deletion in the window which appears.

The user named is no longer authorized to the user file.

Deleting User Files

User files can be deleted online and in batch.

» To delete a user file online:
1. Issue th®ELETE USERFILE userfile-nameommand.

2. Confirm the deletion in the window which appears.

¥ To delete a user file in batch:

® Use the prograrBNDELUF in library SYSSNas described in the sectiBatch Utilities.
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Libraries

This section covers the following topics:
® \What are Libraries?
® Creating Libraries
® |isting Libraries
e Copying Libraries
® Deleting Libraries
® Listing Library Members
® Copying Library Members
® Deleting Library Members

® The Information (Info) Function

What are Libraries?

For a definition of private, public and common libraries| #firaries inUsing Super Naturalin the
Super Natural User’'s Guide

You can perform the following commands on libraries:

ADD MODIFY COPY |DELETE INFO |MEMBER
Private Library X X X
Public Library X X X
Common Library X X X

Super Natural libraries can contain the following types of members:
® Transaction programs
® Prototype programs
e Application programs
® Data models
® [ayout member

® \Work-in-progress layout member
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You can perform the following commands on members:

ADD MODIFY COPY DELETE INFO MEMBER

Member X X X

Creating Libraries
There is ncAAdd Library  function.
» To create a library:
e Copy an existing library specifying the required library prefix for the target library.

Common libraries are not created until they are defined @aimmon Library Definition List
(although they may appear in thibrary List ).

Note:
Libraries are not created until members are copied to them.

Listing Libraries
» To list libraries with a certain prefix and member prefix:
1. Issue th&IBRARY command.
Or:
Select the object Library from the AdministrationMenu.

The Library List screen appears as in the following example:
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14:49 *rxxk Super Natural ***** 1999-05-21
SBE - Library List - SNMLL
More: -+
Library prefix: Y Program prefix: |
Cmd Library Programs
*

__ DD 7
__ DEMO 1
__ESC 58
__ EzZA 48
—_ FHA 1
—_FSO 3
— HAA 9
— HAH 55
__ HAH1 15
_ HAH2 13
__ HAH3 13
HSE 6

Cmd(s): Copy, Delete, Member

Select one command from list

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The Library List screen shows the following:
® Library prefix
® Member prefix
® The libraries defined to Super Natural with the library prefix and member prefix shown
® The number of programs with the prefix shown contained in each library shown
2. Enter the prefix for the type of library you want to see in theLibrary Prefix field.
3. Enter the prefix for the type of program you want to see in theMember prefix field.

The libraries with the prefix specified are listed and the number of programs with the prefix specified
contained in each library is shown.

Copying Libraries

You use theCopy Library  function to copy members of a certain type either to an existing or to a new
library. You can not copy all the members of a library at once. You must copy each member type
separately.

Notes:

1. When you copy a transaction, its layout member is also copied.

2. If you copy transactions created with Super Natural Version 2.4.2 or below, a dummy layout member
is created for each one.

3. You can not copy transactions with transaction mode for reporting Destination USER FILE between
libraries.
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» To copy a library:

e |[ssue theCOPY LIBRARY command specifying source and target library prefix and name as in the
following example:

COPY LIBRARY YTEST | ZPUBLIC |

If you enterCOin the command column of theLibrary List screen next to the library you want to
copy, a window appears which prompts you for prefix and hame information.

A window appears showing which members are currently being copied.If there is already a member
with the same prefix and name in the target library, you are asked if you want to replace (overwrite)
the member in the target library.

Deleting Libraries

You use théelete Library function to delete members with a certain prefix from libraries. You can
not delete all the members of a library at once. You must delete each member type separately.

If you delete all transactions, the layout members which belong to them are also deleted. However, the
work-in-progress layout members are not deleted. Work-in-progress layout members (prefix !) can only be
deleted from theMember List screen.

Note:
A library itself is not deleted until all its members are deleted.

» To delete a library:

1. Issue th®ELETE LIBRARY command specifying library prefix, library name and program prefix
as in the following example:

DELETE LIBRARY YTEST |
2. Confirm the deletion in the window which appears.

All the programs with the prefix specified are deleted from the library.

Or:

EnterDEin the command column of the Library List screen next to the library you want to delete.
3. Confirm the deletion in the window which appears.

All the programs with the prefix specified in the Member prefix field of theLibrary List screen are
deleted from the library.

Note:
You must delete common libraries and their definitions separately.
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Listing Library Members
» To list the members contained in a library:
e |ssue theEMBERommand specifying library-prefix, library-name and program-prefix.

The Member List screen appears:

14:50 *Rkk Super Natural ***** 1999-05-21
SBE - Member List - SNMML
More: +
Library prefix: Y Member prefix: |
Cmd Library Member
SBE___ *
AUTO
CONNECT
CONTROL
CONT2
DATACH
DATACH2
DATACHS3
DATA2
DATAS3
DATA4
DATAS
DATAG6

Cmd(s): Copy, Delete, Info

Select one command from list

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The Member List screen contains the following information:
O Library prefix
O Member prefix

O The name of the library whose members are listed - you can overtype this with another library
ID

O The members with the prefix specified contained in the library specified

Copying Library Members

» To copy a library member:

® |ssue theCOPY MEMBERommand specifying library prefix, library name, member prefix and
member name for both source and target member as in the following example:

COPY MEMBER YSBE ISAMPLE3 CTUTOR ISAMPLE3
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If you enterCOin the command column of theMember list screen next to the member you want to
copy, the Copy Member window appears which prompts you for name and prefix information for the
target library and target prefix.

In some cases, you can not copy a transaction to another library because of layout conflicts.

Note:
You can not copy transactions with transaction mode for reporting Destination USER FILE between

libraries.

Deleting Library Members

» To delete a library member:

® |ssue thdDELETE MEMBERommand specifying library prefix, library name, member prefix and
member name as in the following example:

DELETE MEMBER YSBE ISAMPLE3

Note:
If you enterCOin thecommand column of theMember list screen next to the member you want to

copy, the copy member window appears which prompts you for name and prefix information for the
target library and target prefix.

The Information / Info Function

» To obtain information about a member:

® Enter the command abbreviatibyh in thecommand column of theMember List screen next to the
member name.

Or:

Issue thaNFO MEMBERcommand specifying library prefix, library name, member prefix and
member name as in the following example:

INFO MEMBER YSBE IDATA3

The Transaction Information window appears:
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11:47 Rk Super Natural ***** 1999-05-24
- Member List - SNMML
More: +

e Transaction Information---------------------- +
I Transaction .......... DATA3 Version .... 3.1.0 !
I Created/modified by .. SBE  Date/Time .. 1993/01/12 12:03:00 !
I Description .......... data maintenance transaction t !
! ype UPDATE MULTIPLE !
FType v Update single !
I Selection ............ Full-screen !
| Data change .......... None !
I Report type .......... !
I Report level ......... Detailed !
I Destination .......... Screen !
I Run mode ............. Online !
I Primary file ......... PERSONNEL !
I Sec. file ............ !
I User file ............ !
I I

Cmd(s): Co +More: + +

Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip - + Canc

The Transaction Information window supplies the following information:

O

Transaction name

O Super Natural version with which the transaction was created

O Who created/last modified the transaction

O When the transaction was created/last modified

O User-entered transaction description

O Information about the transaction modes (Report Type, Data Selection etc)
O Primary file

O Secondary file (if defined)

O Name of user file (for Destination USERFILE)

You can page forward to obtain information on the following if relevant to the transaction:

(@]

Link and lookup fields used.

O

Selection criteria

O

Calculation

O

Logical conditions
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O Fields used

When you print the information, you are also provided with information on the entries made in the
Worksheet.
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Common Library Definitions

This section covers the following topics:
® \What are Common Library Definitions?
® Listing Common Library Definitions
® Adding Common Library Definitions

® Deleting Common Library Definitions

What are Common Library Definitions?

A common library definition is a name reserved for a common library which may or may not exist
physically.

You can perform the following commands on common library definitions:

ADD MODIFY COPY DELETE INFO MEMBER
Common X X
Library
Definition

Listing Common Library Definitions
» To list common library definitions:
® [ssue theCOMMOdbmMmMand.
Or:
Select the menu item Common Library Definition from theAdministrationMenu.

The Common Library Definition List screen appears as in the following example:
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14:51 *rxxk Super Natural ***** 1999-05-21
SBE - Common Library Definition List - SNMEL
More: +

Library prefix: C
Cmd Library

AAA
AKE
BRIGGS
DEMO
ERROR
EZA
HWA
KE
KE24
LCCOMM2
NKA
__ NSNCAQ
Add
Cmd(s): Add, Delete
Select one command from list
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The Library List screen shows the following:

O Common library prefix

O Common libraries which are either in use or for which a name has been reserved.

Adding Common Library Definitions

When you add a common library definition, you do not create a common library directly, but reserve a

name for one. A common library does not exist physically until you copy members into it.

» To add a common library definition :
® |ssue theADD COMMQ@&mmon-library-definition-nameommand.

A name is reserved for the a common library.

Deleting Common Library Definitions

When you delete a common library definition, the library becomes unavailable for your users but still

exists physically and is listed in the Libraries List screen.

» To delete a common library definition :

1. Issue th®OELETE COMMOBbmmon library definition -nameommand from theCommon Library

Definition List.
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2. Confirm the deletion in the window which appears.

The library is unavailable to users but still exists physically.
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Special Services

This section covers the following topics:

Invoking the Special Services Menu
® |Importing Users

® Importing Files

o Modifying Multiple Users

e |ayout Standard Title

e JCL Members

Special Services

Invoking the Special Services Menu

» To invoke the Special Services menu:

e |ssue thesPECIAL command from theObject List screens.

Or:

Choose the object Special Services on theAdministration Menu.

The Special Services Menu appears:

14:52 *rxxx Super Natural *****
SBE - Special Services Menu -
More:

IM USER Import Users
IM FILE Import Files

MULT Modify Multiple Users
TITL Layout Standard Title
JCL JCL Members

PROC Super Natural Processor

Select Object
Command ===>

Help Exit Flip

1999-05-21
SNM14
+

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF 7---PF8---PF9---PF10--PF11--PF12---

Canc
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Importing Users

When Super Natural is operating under theNatural Security system, you canmgetheser
function instead of thedd User function to define users.

Note:
Thelmport function is only useful for users of Natural Security.

In order to import file profiles, the applicati® SSNmust bepeople-protectashderNatural Security.
To import users with private files, the private files must be linked to the appliG&YiSSN
» To import users:
1. Issue théMPORT USERamecommand.
Or:
Issue thédMPORT USERcommand.

The Import User screen appears as in the following example:

14:53 *rrek Super Natural ***** 1999-05-21
DBA - Import User - SNMUI
More: +

User ID Private Files

*

ANS

APAXF

AZE

AZE1

AZES5

BBU

BBUBAT

BBUUSER1

BGW

BKA

BSE

BTO

BVUS

CF

Mark users to be imported into SYSSN

Command ===>

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc

The screen lists the users defined under Natural Security and displays the number of private files for

each user.
If you specified a user name, the list starts from that name.

Natural Security users of the tyfesminal andGroup are not listed.
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2. Mark the users to be imported.
3. Press Enter.
The users’ private files are added/linked automatically, if they are not yet defined to Super Natural.

Users already defined to Super Natural are shown on the list, but can not be marked.

Importing Files

When Super Natural is operating under theNatural Security system, you canmgethEile
function instead of thdd File  function to define users. You can import both private and public files.

Notes:

1. The Import function is only available for users of Natural Security.

2. In order to import file profiles, the applicat®¥iSSNmust b@eople-protectadhderNatural
Security. Private files must be linked to the applica8M8SN

» To import a file:
1. Issue théMPORT FILE namecommand.
Or:
Issue thédMPORT FILE command.

The Import File >Private screen appears as in the following example:

14:54 *Rk% Super Natural ***** 1999-05-21
DBA - Import File >Private - SNMFI
File Name Type
*
_ CO-AGREEMENT Priv
_ COMMAND-SSZ Priv
_ UF-SEK-BSP51 Priv
_ UF-SEK-BSP6 Priv
>Public
Mark files to be imported to SYSSN
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc
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5. Modify the file options as described in the section Files earlier in this documentation if required.

The screen lists the private files that are already linked to the appli&B8N

Files already defined to Super Natural are shown on the list, but an not be marked.

If you want to import a public file, issue #&UBLIC command.

The Import File >Public screen appears. The screen lists the public files that are already linked to the
applicatiorBYSSN Files already defined toSuper Natural are shown on the list, but can not be
marked.

Select the file(s) to be imported.

Press Enter.

The file(s) are imported and the Modify File >Options screen for the first file selected appears.

Modifying Multiple Users

You use theviodify Multiple Users

ofSuper Natural ) to unify the options of multiple (or all) users.

» To modify multiple users:

1.

Issue thiTULTIMODcommand.

The Modify Multiple Users window appears:

11.08

*rxxx Super Natural ***** 1999-05-24
- Special Services Menu - SNM14

oo Modify Multiple Users--------- +
|

IM USER Import Users ! Enter a user ID to get the options of !
IM FILE Import Files ! this user as default options. !

I If using "*******' you will get the !
MULT Modify Multiple ! global options as default. !

| |

TITL Layout Standard ! User ID: !
! !

JCL JCL Members + +

2. Enter the user ID whose options you want all or multiple users to get.
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11:11 Rk Super Natural ***** 1999-05-24
- Modify Multiple Users >Options - SRMUQO
Maintenance Authorization / Language / Prefixes
Sizes / Numbers / User Files
Database Access
Database Access and JCL
Data Maintenance Transaction Type / Data Selection
Report Type / Report Level

Report Destination / Run Mode / Batch Job Entry

Display Options

>Users

Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

3. Modify the user options as described in the sedfiodifying Single Usersearlier in this section if
required.

4. SelectUsers .

The Modify Multiple Users >Users screen appears as in the following example:

11:12 Rk Super Natural ***** 1999-05-24
- Modify Multiple Users >Users - SNMUQL
More: +
User ID
*
|k _ AA92 _ CALL'C _ DP
_A _ AA93 _ CCA _ Dbs
_AA _ AAY4 _ CCH _ Dw
_ AAL _ AKR _CF _ ESC
_ AA2 _ ALO _ CHEF _ EZA
_ AA3 _ AS _ CMR _ FHA
_ AA4 _AZ _CR _ FK
_ AA5 _ Al _ DA _FS
_ AA6 _ BF _ DBA _ FSO
_ AATY _ BFA _ DEMO _FT
_ AA8 _ BFB _ DEMO1 _ GAS
_ AA9 _ BFC _ DEMO2 _ GBAH
_ AA91 _ BS _ DOG _ GBBW
Mark users for function Modify Multiple
Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc
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5. Mark the users you want to give the new user options.
Marked users are modified when you do one of the following:
® |ssue a paging command.
® Press Enter.

® Press$F3.

Layout Standard Title

You use thd.ayout Standard Title function to edit the standard Title element which is generated
for all reports at your site. For example, you may want the name of the company to appear at the top of all
reports. Users can edit the Title element in each report.

Editing the Layout Standard Title Element

» To edit the standard Title layout element:
1. Issue th@ITLE command.

The Layout Editor appears with the Standard Title element currently defined at your site in the editor
area.

2. Edit the Standard Title as described in the sedtainral Report Managerin theSuper
NaturalUser’s Guide

Super Natural provides the following default Standard Title element:

— AT with VYUY —kiki—DD *FAGE—MUMEER —
% Lines —
/—14:5 £+% NATURNL WEPORT MEMAGER %+ 1993 5—2§
Layolit STOTITLE - Layont Edifor - WRMEDIT
tore: =
Transaction Fields Dflindter Class — Attrdik. Colo
1 *DATD B Elank Text Defanlt
2 *DATE B : Texnt Intens.
I SDATE a5 [ output  Default
d *DATI B 1 output  Intens.
5 *DATT S
£ *DATN M0 Efcape Char. = . Header Char. § &
211 | --—0d0-——4———————————030-- [ Title | +———050-——d—m—————————0F0--} Ty
(MEEEEEEEEL [999TE1
[HEREEEEE TH1
[HERHEREE Tr1

Yo |are poo the £irst page.
Comand ===
Enter-PrH--—FF2-- PP 3—--PFd——-PF5—— PP E——-PF7——-PF&——-FFO——-FF10--FF11--PF12-—

\ Heflp Set  Exdit Tield Bdit Flip - + Tech < = Canc -/

— *FPROGE
[trows Actiom nowne wd prefiz)

*Thix —
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System Variables

The Natural system variables available in Super Natural are listed in the Transaction Fields section of the
split-screen Layout Editor. For further information on system variable§ystem Variablesin the
Super Natural User’'s Guide

S Lines

The S lines are a placeholder for up to 5 lines of selection criteria. Each S line contains 60 Ss. If you either
add or erase Ss from the S lines, the Ss are interpreted as text. You can edit the S lines if you wish, for
example, you can move them two lines down and enter text above them.

Deleting the Standard Title

You can delete the contents of the Standard Title member in the Super Natural Administration application.
The next time you choose Layout Standard Title from the Special Services menu, the Layout Standard
Title window appears where you can choose between editing the empty Standard Title and regenerating
theSuper Natural default Standard Title.

You can delete the Standard Title membe8¥SSN however it is regenerated the next time a layout is
generated for a transaction.

JCL Members

You use theJCL Members function to maintain JCL members using the Natut&8 command. By
default, each JCL member is stored in librAdL . Choosing JCL Members from the Special Services
menu is the same as issuing the following Natural commands:

LOGON LIBRARY ZJCLLIST *

A user can only have access to one JCL at a time. However, you may create several JCL's in the library
ZJCL. You can change user access to JCLs as necessary using user options.

You can perform the following commands on JCL members:

DELETE EDIT LIST PRINT RENAME
JCL Member X X X X X

Although other commands are available using the Nati8a@l command, these are the only commands
necessary for JCL member administration.

For further information on using Super Natural in Batch ModeBaieh Processing

The libraryZJCL should only be used for storing JCL members.

Invoking the JCL Members Function

» To invoke the JCL Members function:
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1. Issue thd CL command.

You have now accessed the Natud®dT command. The Natural LIST COMMAND LIST P *
screen appears as in the following example:

14:59:24 *x Natural LIST COMMAND ***xx 1999-05-21
User SBE LISTP * Library ZJCL

Cmd Name  Type S/C SM Vers Level User-ID Date  Time

_ JCLCF Program S R 2.2 0004 CF 92-12-21 11:30:22
JCLHAH Program S R 2.2 0005 HAH 93-05-17 14:51:53
JCLO1 Program S R 2.2 0003 AR 92-06-11 18:14:13

_ JCLO02 Program S R 2.2 0003 WRKMKO 92-09-18 14:07:28

From (New start value) 4 Objects found
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit - -+ Canc

Deleting JCL Members

» To delete a JCL member
1. EnteDEin the command column next to the JCL member you want to delete.
2. Confirm the deletion in the window which appears.

The JCL member is deleted.

Editing JCL Members

» To edit a JCL member
e EnterEDin the command column next to the JCL member you want to edit.

The Natural Program Editor appears where you can edit the JCL member. For information on editor
handling, see thMatural Reference documentation

Listing JCL Members

» To list a JCL member

e EnterLl inthe command column next to the JCL member you want to list.
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The JCL member is displayed in the Natural Program Editor. For further information on the Natural
Program Editor, see thidatural Reference Documentation

Printing JCL Members

» To print a JCL member
® EnterPRin the command column next to the JCL member you want to print.

The JCL member is printed.

Renaming JCL Members
» To rename a JCL member:
1. EnterREin the command column next to the JCL member you want to rename.
2. Type a new name in the window which appears.
JCL member names can have 1 to 8 characters.
3. Press Enter.
The JCL member is renamed.

For further information on the NatutdST command, see theatural Reference documentation

Writing JCL Members

For information on creating JCL members, ¥égting JCL ProceduresinBatch Processing
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Batch Processing

This section describes set-up for batch transactions, RJE, JCL and the Super Natural batch utilities.
This section covers the following topics:

e What is Batch Processing?

® Setting Up Batch Processing

® Setting Up Batch Processing for Remote Job Entry (RJE)

e \Writing JCL Members

e Maintaining JCL Members

® Notes for Natural Security Users

® Job Submission

What is Batch Processing?

You use batch processing to manage resources efficiently by processing large numbers of records and
printing long reports at off-peak times.

In order to run transactions in Batch mode, you must have &lttaral PROCESSor NATRJE for

your environment. You maintain the control procedures for your system environment in theSuper Natural
Administration application using the JCL Members function which in turn accesses the IN&fral
command.

The Super Natural administrator must organize the following:
® Setting Super Natural user options
® Deciding which users should be able to create and run batch transactions
® \Writing JCL procedures
® Maintaining JCL members
e Deciding how batch jobs should be submitted
® Security and other issues.
By default, each JCL is stored in libragyCL .
JCL member names should have 1 to 8 characters.

A user can only have access to one JCL at a time. However, you may create several JCL members in the
library ZJCL. You can change user access to JCL members as necessary in their user options.
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Variable parameters which must be changed by the user before execution of the batch job can be defined
using text strings as long as they do not coincide with the job control language. You can modify the
system exiSPRJEU so that it can provide the control procedure with user variables.

Once a job has been submitted to run a Super Natural batch transaction, do not modify the transaction
until after the job has been run. Modifying the transaction can either cause an error or incorrect resulting
data. For example, if a user changes the transaction defaults to Run Mode: ONLINE between batch job
submission and execution, the batch job will terminate with an error.

Notes:

1. Super Natural batch transactions terminate the batch Natural session.

2. Note for BS2000 users:
If you want to run a batch transaction online, do not gerteféigparameters. For further
information ofETID parameters, see yoNatural Security documentation

3. Itis not possible to run transactions which use dynamic input fields in Batch mode.

Setting Up Batch Processing

» To enable a user to run transactions in Batch mode:
1. Assign the desired logical printer number for transactions in Batch mode.
2. Set the optiodCL ID to determine which JCL member the user will use (def4iii01).
3. Set the appropriate user options forReport/Logging Destinationto"Y".
The following Report/Logging Destinations are available for transactions in Batch mode:
® PRINTER
e WORK FILE
® CON-NECT
e USER FILE
4. Set the user option Run Mode: Batchto"Y".

5. Set théNatural PRINTER  parameter high enough for the code generated by Super Natural to pass
the syntax checker in the online Natural session in which Super Natural is running.

For example, if the report destination is logical printer number 8, PRINTER=8 (or higher) must be
used. You can check the printer, work file and PC file numbers allocated using the Natural
utility SYSDBA

You can set th@RINTER parameter in tiéATPARM module or dynamically.
The user can now save and run batch transactions.

You can also authorize users to use certain user options (for example, non-descriptor criteria) only in
Batch mode.
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Setting Up Batch Processing for Remote Job Entry - RJE

The RJE facility allows users to submit batch transactions from within Super Natural without having to
write the JCL themselves.

» To enable a user to submit batch jobs by RJE:
1. Set the user’s options as described in the section Setting Up Batch Processing earlier in this section.
2. Set the user option Batch Job Entry: RJE Availableto"Y".
3. Code the JCL for the Natural batch job.

You can specify unique JCL members for each user, or more than one user for the same JCL. For
further information, sedCL Members in Special Services for Batch Transactions

4. Store JCL members as source members in the Natural [flaty.

To activate batch RJE, the user must set the transaction mode Run Mode to "B" MDD EHE:
command from within the transaction he wants to submit.

Now the user can run transactions in Batch mode and the batch jobs will be automatically submitted.

Writing JCL Members

JCL members for use with Super Natural RJE are written the same way as any Natural batch job for your
site, except for theSuper Natural special characters described below.

Special Characters

The following special characters are available when creating or modifying JCL members for the
submission of batch transactions:

Insert Character > (Mandatory)
Code the insert character ">" in column two on a line by itself.
Super Natural inserts the corle@GONindEXcommands when the transaction is submitted to RJE.

The insert character ">" allows a JCL member to be used repeatedly by the same and multiple users
without modification.

Example:
The following example shows how the insert character ">" works. The insert character is used in the JCL
for a transaction name®EPORT1 for the user USERIDas follows:

>FIN

When the job is submitted, Super Natural inserts commands to change the instream data to the following:
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LOGON SYSSNEX IREPORT1 YUSERIDFIN
wherel is the program prefix for transactions, and the private library prefix.
User ID Generation (Recommended)

The characters "*******" gre replaced by the User ID at the time the transaction is submitted for
execution. You can use this character string in the job card.

Transaction Name Generation (Optional)

The characters "#######" are replaced by the transaction name when the transaction is submitted for
execution as in the following example:

Example:

[Poxsx JOB #tHH#H#H, MSGCLASS=X, CLASS=G//INATBAT EXEC

Active PSB Name Generation (Optional)

The characters "pppppppp" are replaced by the &$Beame DL/I files) at the time the transaction is
submitted for execution (only DL/ files ).

Maintaining JCL Members

For information on maintaining JCL members, 3€& Members in Special Services

Notes for Natural Security Users

The Natural Security environment must be set up so that the startup pigtdbh is active when batch
processing is invokeddENU reads theNatural commands which follow as input data, and controls the
execution of the transaction.

If there is not a control record for the transaction, batch processing is not started.

The control record is created from the online environment before batch processing is started. Batch
transactions are registered withSuper Natural.

Transactions which are not registered with Super Natural can only be run if they are in the private library
of the user, in a public library the user can access or if the relevant library is defined under Natural
Security and the transaction processing is started from that library.

Set-Up

Super Natural must be set up according to the instructions Buier Natural Installation
documentation
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AUTO=0ON
User TypePerson orAdministrator

If the user submitting the batch job is defined to Natural Security as a user of fherggye or
Administrator andAUTO=0M specified, the job name itself is used to perform the logon and
theNatural Security logon need not be coded in your JCL. For further informati@grsgating User
ID’s inDynamic Features

User Type Member

If the user is defined as a user of the iipeber, AUTO=0Nan still be used if the default application
for that user ID iISYSSN

If the member’s default application is &Y SSN theNatural Security logon commands must be coded in
the JCL as in the following example:

SYSSN, USERID%*PASSWORD
RESTART=N (Natural Security Version 2)

In Natural Security Version 2, define the applicat8¥iSSNwithRESTART=Kn the application profile.
Restart data is not used in Super Natural, and turRESF ARToff will prevent a duplicate user ID from
occurring.

Insert Character ">"

If Natural Security is installed, use the insert character ">"as the Super N#Eddlprogram expects the
execute card in a specific format. For further information on the insert character'Sfieses
Characters inWriting JCL Memebers.

If the RJE facility is being used to submit batch jobs fromSuper Natural, use the insert character">" which
allows Super Natural to insert t@GON SYSSMndEX IPGMNAME YLIBRARYcommands. For
further information on the insert character ">", Special Charactersin Writing JCL Members .

If you do not use the RJE facility (ie, the JCL is to be submitted outside of Super Natural), you can code
theNatural control statements in two ways.

If private libraries are not defined to Natural Security code the Natural control statements as follows:

LOGON SYSSN
EX IPGMNAME YLIBRARY

If private libraries are defined to Natural Security code the Natural control statements as follows:

LOGON YLIBRARY
EX IPGMNAME

Naming Conventions:

If you do not use the insert character ">", and hard-code the control statements, the transaction name must
consist of eight positions. If the name has less than eight characters, it must be padded to eight positions
with trailing blanks. For example, if you want to run the transadfi&@sT in library YSALZC, the

following will result in an error under Natural Security:
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LOGON SYSSN
EXITEST YSALZC

The correct version is as follows:

LOGON SYSSN
EX ITEST<blank>AAA <blank> <blank>AAA <blank>YSALZC

Super Natural generates the commands correctly when the insert character ">" is used. For further
information on the insert character ">", &gecial Charactersin Writing JCL Members .

Job Submission

JCL members for external submission are coded the same way as anyNatural batch jobs for your site.

To log on toSYSSNand execute the transaction from the user’s private library, code the Natural control
statements as follows:

LOGON SYSSN
EX IPGMNAME YLIBRARY

To log on directly to the private library and execute the transaction, write the Natural control statements as
follows:

LOGON YLIBRARYEX IPGMNAME

Note:
Users of Natural Security should dkses for Natural Security User@n Batch Processing

Submitting Batch Jobs Using Natural PROCESS

» To submit batch jobs using Natural PROCESS:
1. Change the submission indicator in theNaturalsubpro§RIBARM from RJE to NPR.
2. Specify a process node ID.

For further information, sethe SPPARM source

Modifying Submitted Batch Jobs - SPRJEU
The Natural subprogra®PRJEUSs delivered in source form.

When Super Natural transactions are run in Batch mode, the subp®BRMEU is executed once for
every job card prior to the submission of the joiN&YTRJE.

You can usé&NATRJE to add, modify and delete job cards. For further informationthee8PRJIEU
source
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Batch Utilities

This section describes the batch utilities provided with Super Natural.
This section covers the following topics:

® What are Batch Utilities?

e Unloading and Loading Super NaturalData

e SNULD

e SNLOAD

® SNDELUF2 - Deleting User Files in Batch

® SNSORTFI - Sorting File Links in User Profiles

What are Batch Utilities?

Super Natural provides the following batch utilities:

Batch Utility Description

SNULD Unloads profile data and transaction specifications
SNLOAD Loads profile data and transaction specifications
SNDELUF Deletes user files

SNSORTFI Sorts file links in user profiles

Unloading and LoadingSuper Natural Data

You use the utilitieSNULDandSNLOAD to copy Super Naturaluser profile data, file profile data, help
texts, and transaction specifications between different Naturaluser systefUitssK). You can also
useéSNULDto delete profile data and help texts.

Notes:

1. You can not load help texts from Super Natural 2.3 to a Super Natural 3.1 environment.

2. Do not use the Natural utiliti&Y SMAIN, SYSMAIN2orULDMAIN to copy or move Super
Natural transactions between system files. These utilities only copy up to 80 characters per source
line and Super Natural specifications contain up to 250 characters per line.

3. TheFDIC file in the target environment must be the same as that in the original environment if you
want to use existing transactions.

UseSYSMAIN or NATUNLD/NATLOAD to copy or move JCL members, prototype programs and
objects between system files.
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For further information o SNULDandSNLOAD, see the following sections.

SNULD

The progranSNULD in librarySYSSNinloads Super Natural user profile data, file profile data, help texts
and transaction specifications from the current Natural user systefAUiBER) to sequential work file 4
in a form suitable to be reloaded using the pro@&iOAD.

The following table shows which functions are available for batch jobs$NidgD and which
parameters are required:

Function Code Object Name Language Code Library

*

D Required

F Optional

H Optional Optional

S Required Required
U Optional

Functions

* Function

The* function unloads all user and file profiles and help texts. It does not unload transactions.
D Function

The D function deletes objects according to the object name parameter specified. You can use the
following object name parameters with fhéunction:

* File profile data, user profile data and help texts

File profile data

H Help texts (language specific)

U User profile data

All objects of the type specified are deleted.
F Function

TheF function unloads either all file profiles (including user file and superfile profiles) or named file
profiles. It does not unload the sources (transaction specifications) of superfiles.
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H Function
TheH function unloads either all or named help texts either in all languages or in a specified language.

Note:
You can not load help texts from Super Natural2.3 to a Super Natural 3.1 environment.

S Function

The S function unloads transaction specifications. It does not unload the generated source code and
theNaturalobject code. To regenerate theNatural source and object code, you must modify and save every
transaction.

You can also usgLDMAIN to copy the transaction objects, so the transactions can be run immediately
in the new environment.

If you do not specify a transaction name and library name containing the appropriate prefix, all transaction
specifications and layouts from all libraries are unloaded.

If you use the asterisk notation (*) following the prefix, all transaction specifications and layouts or
libraries with that prefix are unloaded.

U Function

The U function unloads either all or named user profiles.

Parameters

Parameters must be entered after the function code in the following order:

function-code,object-name,language-code,library

The parameters must be separated from the code and from one another by the Natural delimiter character.
If one of the parameters is not specified, or not applicable, the character preceding it is still required. For
example, if you want to unload all English help texts, the parameters must be spedifidd as:

You can use the asterisk notation with the parameters to further limit the object name and library of the
items to be unloaded. For example the not&joR*,,Y* would unload all transactions whose name
begins with TR in the library with prefix "Y".

Each function must be written on a separate line (along with its parameters).

Examples of Recommended Syntax

Example 1

LOGON SYSSNSNULDH,,1S,TR*,,Y*.FIN
1: Unloads all English help texts.

2: Unloads all transactions whose names start with TR in libraries with the prefix Y.
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Example 2

LOGON SYSSNSNULDS,*,,Y*.FIN

Unloads all transactions in all private libraries with the prefix Y.

Example 3

LOGON SYSSNSNULDS,IPGMNAME,,YUSERID.FIN

Unloads the specified transaction in the library given.

Example 4

LOGON SYSSNSNULDS, I*,,YUSERID.FIN
Unloads all transactions in the specified library whose name start with |.

Example 5

LOGON SYSSNSNULDS,*,,YUSERID.FIN
Unloads all transactions in the specified library.

Example 6

LOGON SYSSNSNULDF,*S,*, public-library-prefixSUPFILE.FIN
1: Unloads all file profiles including user file and superfile profiles.

2: Unloads the sources (transaction specifications) of the superfiles.

SNLOAD

The progranSNLOAD in librarySYSSNoads Super Natural user and file profile data, help texts and
transaction specifications from sequential work file 4 to a user systerRUil#HR). The data must be in
the same format as achieved by unloading Super Natural data using the (Bolsam.

» To load Super Natural data:

e Specify the following in a batchNaturalsession:

LOGON SYSSNSNLOAD.FIN

SNDELUF2 - Deleting User Files in Batch

SNDELUF2 replacesSNDELUF and is used to delete user files in b&8&NDELUF2 caters for the
extended ranges of FNR and DBID available with NaturalVersion 2.3.

Notes:

1. SNDELUF is still available for compatability reasons.
2. When deleting user files in batch, the same JCL is used for the active user as for running transactions
in batch mode.
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3. When user files are deleted using RJE, the batch job must have the same input delimiter as the online
session (Natural parameter ID).

» To delete user files in batch:

® |ssue the commandOGON SYSSN
SNDELUFDarameterl,parameter2,parameter3,parameter4,parametersirHhe librarySYSSN

You can use the following parameters:

Note:
Parameters must be in delimiter mode (NaturalpararidteD).

parameterl
DBID-FNR (N10)

Specify the physical Adabas file and database ID (DBID (N5) FNR (N5)) of the Super Natural personal
database.

parameter2
User ID (A7)

Specify the ID of the user for whom the files are to be delEdlD indicates the end of the
sequencéALL indicatesall users

parameter3
File Name (A20)

Specify which file is to be processdiiank () indicatesall files

parameter4
Status (A3)

Specify which of the processed files are to be delétadk () indicates all files marked by the user
for deletion and all files with expired retention perigdlLindicatesll files .DATindicates
unconditional deletion of all specified data.

parameters
User File DDM Prefix (A2)

Specify the user file DDM prefix as defined in the options (defllt

SNSORTFI - Sorting File Links in User Profiles

The utility SNSORTFI should be used in batch mode. It sorts alphabetically the files that are linked to a
user profile so that the file list at transaction creation is displayed in alphabetical order.
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This utility should be used from time to time when new files are added to aSuper Natural environment and
are linked with users through the file profile. In this case, the file list of the user is not newly sorted
alphabetically. Instead, the file is added to the end of the list.

Note:
When a new file is linked through a user profile, the files of this user are automatically newly sorted.

File links in user profiles are sorted by using the pro@E®ORTFI in library SYSSNin the form:
LOGON SYSSNSNSORTFI

parameter
FIN

parameter

User ID (A7)

If parameter is blank, file links of all user profiles are sort®drameter can be used in any of the
following forms:

NAME sorts file links in one specific user profile

NAM* sorts file links in all user profiles starting with NAM

NAM< sorts file links in all user profiles from the beginning until NAM

NAM> sorts file links in all user profiles from NAM until the end
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Exit Programs

This section describes how to define and store exit programs.

It is the administrator’s responsibility to ensure that user exit programs do not have adverse effects on
Super Natural!

This section covers the following topics:
® \What are Exit Programs?
® User Exits

® System Exits

What are Exit Programs?
There are two kinds of exit programs in Super Natural:
® User exits

® System exits

User EXits

User exits can be invoked from up to ten places within a transaction at run time. The user defines which
exits he wants to use, the location and any parameters. An exit can be any of the following:

® Subprogram invoked bgALL statement

Natural program

Natural subprogram

Natural subroutine

Natural map

User exits which are Natural objects must be stored in the S&8IBEM or in the current user’s private
library.

Super Natural recognizes the exit type and automatically generates the relevant Natural statements such
ad-ETCH RETURNCALLNATrPERFORMNd passes parameters.

Note:
You can prevent the modification of exits in transactions in a public library or in transactions which will
be used as a superfile using tl@CKcommand.
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Writing User Exits

When you are writing a user exit program, consider the following points:
Program Type

An exit program must be one of the following:

® An external program (e.g., COBOL or ASSEMBLER subprogram) callable by aN@tial
statement
OR

® One of the Natural object types listed in the previous section.
Parameters

Parameters must correspond with the call of the external program as use@GAd th&atement; or with
the parameter list used in the Naturalmodule

If the exit program requires parameters, the user must specify them manually u&riy the
Specification function.

Connecting User Exits to a File
» To connect a user exit program with a file:

® Change the file options as described in the se&ianSpecification in the sectiorfiles.
Informing Users

Do not forget to provide the users with the program names of the user exits available to them, and tell
them which parameters are to be passed to the subprogram.

Storing User Exit Object Modules
Natural Objects
The object modules ofNaturalprograms, subprograms, subroutines, or maps can be stored as follows:

® In the steplilSYSTEM (FUSERorFNAT) - all users of Super Natural can access these modules
from their private libraries and from any common library. This is recommended in most cases.
OR

® In the private Super Natural libraries of selected users - only the selected users can use these user
exits. IfSuper Natural is running underNatural Security, the private library of each of the selected
users must be defined to Natural Security.
OR

® |n the appropriate common library if the transaction from which the module is called is either
executed in a common library or was added in a common library.
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Note:
When you copy a transaction which uses user exits, you must make sure that the user exit object modules
are available in the target environment as described above.

Non-Natural Programs

For information on storing object modules of external (non-Natural) programs, contact your Natural
administrator or see yolNatural documentatian

System Exits

You use system exits to take control at a certain point inSuper Natural. The following system exits are
supplied withSuper Natural in source code:

ENTRY Program invoked as entry routine for theSuper Natural session.
EXIT Program invoked as exit routine when theSuper Natural session is terminated.
SHEXIT Program which takes over if the user presses.

SNERRU Program invoked by error routiS8lRTE. SNERRU can be modified to handle specific error
conditions. For example, you can 88ERRU to give the user additional information or
instructions when an error occurs.

SPRJEU Naturalsubprogram which is executed once for every job card prior to the submission of a
batch job.

SPPARM Subprogram to define environment specific parameter settings. Parameters include: - The
submission indicator for batch job submission (RJE or NPR) - Com-Plete hardcopy support -
default printer number generation or prompting for destination (default) - Common library
prefix character - only change at installation - Layout prefix character - only change at
installation

You can modify these user exits if required.
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Technical Information

This section gives you technical information on how Super Natural processes data. This technical
information is intended to help you increase the performance of Super Natural, estimate resource
requirements and tells you how to work with certain profile settings.

This section covers the following topics:
e Super NaturalandNatural
® Data Selection and Performance
® Sort
® Personal Database
e Error Logging
® DDM Check on Modify
® Status Reports
® RPC Service
® Memory Requirements
e Communication with Other Applications
® The Technical Information Function
® [ayout Members
® Passwords and Cipher Code

® User Profile, Option and Adabas Password Hierarchies

Super Natural and Natural

Programs

The transaction is the major part of Super Natural. Users define transaction specifications using the
menu-driven user interface and Super Naturalgenerates a Natural program from the transaction
specification.

The Natural programs generated fromSuper Natural transactions are saved, cataloged and run by Natural
commands like any otherNatural program. One of the advantages of this is that Predict X ref data (active
cross references) can be created automatically.

Note:
If you use Natural Optimizer Compiler, optimized object code is generated.
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In order to generate source code flexibly, Super Natural still generates code with Reporting Mode syntax.
This however does not effect performance negatively.

Each Natural program generated from a Super Natural transaction has a block of commentary lines before
the source code. The size of the commentary line block depends on the transaction specification.

As opposed to source code which is only relevant at the time of compilation, the block of commentary
lines contains all the information necessary for Super Natural about the program which is to be generated
and may not be modified under any circumstance.

The Natural ESIZE required for a transaction depends mostly on the number of fields contained in the
DDM used. Information on each field contained in the DDM is stored in the ESIZE. The most efficient
way of minimizing the ESIZE requirement is to minimize the number of fields in each DDM. The user
can also physically remove the fields not needed for a transaction from the source area before running a
transaction using theELEASEcommand. The fields removed are no longer available for that transaction.

Libraries and Prefixes

The Natural objects which are created (programs in source and object code) are stored in Naturallibraries
belonging to Super Natural. The names of these libraries are composed of an internal prefix and a library
ID. There are three types of Super Natural library which are distinguished for administration purposes by

an internal prefix:

® Private
Belong to one user. The library name consists of an internal prefix and the user ID.

® Public
Created by the administrator copying objects into them. Only the administrator can copy objects into
a public library. Can be used by all those who have the same public library prefix.

e Common
Can be used by all users. Users can copy objects into a common library. In order to prevent users
creating common libraries at will, the administrator must name each common library the user can
use.

Within each library the different object types and transaction layouts are distinguished by their individual
prefixes. For example, all transactions begin with the ptefixodifiable) followed by the user-defined
transaction name and have a layout with the same name but with the_pedix only be modified
iINSPPARM during installation).

Natural Security Considerations

The libraries used by Super Natural need not be defined to Natural Security. This means that you do not
have to define all private files both to the applica8¥®&SNand to every Super Natural library. As soon
asSuper Natural is active, the security profile of the applicA¥&@ENis valid for all Super Natural

libraries.

Note:
The profile ofSYSSNshould be set up so that the applicatiopeisple protectedndCommand Modeis
Allowed
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When generating a prototype program or using the Super Natural Report Destination EDITOR, a user
could write programs to access all files define@¥%5SSN To prevent this,Natural performs an additional
security check of the user’s Super Natural profile. If the user is not authorized to access the current file, he
receives Natural Security messages.

System Components

The Super Natural Processor consists of three components:
® |Interaction
® Generation
e Execution of program generated

Interaction

All user entries are written to the Natural source area or to the side source buffer using Assembler
subprograms. Most database access takes place for the following:

® Displaying object lists
e Reading the DDMs used in the transaction
e Displaying system messages and error messages
e Displaying Precict information
® Notepad function
® Values function
e Count function
Generation

During generation, processing takes places directly in the source area and all relevant information is read
from the internal code table and converted to the relevant Natural notation.

Execution
After generation, the execution can be done in conclusion with the generation or as a single command.
The following Super Natural commands can be issued:

® SAVE When th&AVEEommand is issued in Super Natural, the followingNatural commands are
executed:

© RENUMBER

O SAVE
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O CATALOG

e RUN When th®@UNommand is issued in Super Natural, the followingNatural commands are
executed:

O RENUMBER
O SAVE

O CATALOG
O EXECUTE

e EXECUTEWhen a transaction is executed from the Transaction list, the following Natural command
is executed:

O EXECUTE
The Natural object is executed but not regenerated, saved and cataloged.

Note:
If you issue th&XECUTEcommand when the database has been modified since the transaction
was run, or if data maintenance has taken place, your results will not be up to date.

e KEEP When th&KEERcommand is issued in Super Natural, the followingNatural command is
executed:

O SAVE

Only the transaction specification (commentary lines) is saved and the transaction program is
not generated. You can not execute a transaction having just issideBEReommand.

DDM Field Names

Do not use Natural key words as field names in DDMs to be used by Super Natural.

Natural Profile Parameters
It is recommended that all users of Super Naturalhave the same Natural profile parameters.

If you run a transaction which was created under a differentNatural profile to yours, you may receive
errors. Problems may occur if, for example the global pararbeteirnal Character or Control
Character are different for users of the same common library.

Data Selection and Performance

READBtatements take priority ovBIND statements for database access. Whenever the selection criteria
allow, the query is realized using a logical sequential readFIMIB statement is only used for complex
selection criteria or when a logical sequential read is not possible.
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Examples:

descriptor>value | Can not be realized using a logical sequential read and resuREND a
statement.

descriptor>=valu( Results in &READstatement

If you use fields which are not descriptors in a query, post selection using a WHERE clause takes place.

The number of single selection criteria as well as the authorization to use non-descriptors can be
determined by the administrator in a user’s profile. The administrator can also determine whether a user
may read a file physically.

Note:
The above does not apply when uSal -SELECTstatements.

Post selection in user-defined logical condition statements is realized using the keA@OERTand
REJECT This means that dependent on the result of a computation, a record which has been read can be
either used in further processing or rejected.

COUNT Function

This function counts the number of records found by the current selection criteria ugthigbhe
NUMBERtatement where possible. TR&D NUMBERstatement can not be used in the following cases:

e f the database management system doesn’t allow it
® non-descriptors are used

e for the primary file when files are linked.

VALUE Function

This function results in IISTOGRAMtatement using a descriptor value and can only be used if the data
storage system supports it.

Performance Considerations for Mixed Format Calculation Expressions
How to achieve optimum performance when using mixed format expressions:

® Use packed format (P) for business arithmetic. The number of decimal digits in all operands should
agree where possible.

e Use floating point format (F) for scientific arithmetic.

e Avoid mixed format expressions. In expressions where formats are mixed between numeric (N, P)
and floating point (F), data is converted to floating point format. The conversion between the formats
numeric and floating point results in considerable CPU load.
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Sort

Super Natural sorts as follows:
® Database sort (if supported)
OR
® External sort or operating system sort
The database sort is used when a sort using up to three descriptors or a non-descriptor is required.

If a sort using more than three descriptors or a non-descriptor is required, aN@Rdtatement is
generated. ThEORTstatement initiates an external or operating sort depending on your environment.

A SORTstatement is also generated if a post selection fok@@EPTandREJECTkeywords in logical
condition statements is required together with system functions. This prevents rejected records being used
in control break processing and for the system functions.

The authorization for both types of sort is separate for online and batch processing.

SORTSZE

Super Natural uses theNatuBDRTstatement when a transaction program is generated to sort the display
fields into the order required. Because the memory necessary for this can not be allocatedS@RITthe
statement is performed, run time errors (NAT0910, NAT1202) may occur if the value of the
NaturaBORTSZparameter is larger than the total memory capacity available.

A minimum value of 10KB (the Natural default value) is sufficient for internal sorts.

Personal Database

The personal database consists of one or more physical Adabasfiles. Each user works on one file which is
determined in his profile. The number of the Adabas file is given to Natural when the user logs on to
Super Natural which means that theNatlWw/lLE parameter is not needed.

Each physicalAdabas personal database file has a Master DDM which describes how many descriptors
and elementary fields of which format and length are available for user files.

The Master DDM describes the following:
e Control field AA
e Numeric descriptors
e Alphanumeric descriptors
® Numeric fields

® Alphanumeric fields
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The descriptors identified in the Master DDM are defined with different lengths and the elementary fields
are defined with a length of 1. All fields except for AA and CA are defined with null-value suppression.

The physical definition or Field Description Table (FDT) consists of the following:

Internal control field AA(N8)

Numeric fields (not in packed format),

Alphanumeric fields,

Binary superdescriptors

Alphanumeric superdescriptors

The superdescriptors identified in the FDT consist of the field AA and a descriptor identified in the Master
DDM. Because of this, the length of the descriptors in the Master DDM is predefined.

When a user file is created, a DDM is generated according to the user input. All the descriptors required
are identified with an Adabasfield reference in the Master DDM according to their length. Descriptors in
the user file can be shorter but not longer than their counterpart in the Master DDM. All elementary fields
are created with the length required as these can be dynamically extended by Adabas.

The non null-value suppressed descrif@éiis used to guarantee that all data (including zero information)

in a user file can be retrievedAmust be present in every user file. When aNatural program accesses a
user file, the Natural descriptor access is converted to access via the corresponding superdescriptor. This
means that users can only perforfREBAD PHY SICALon his own user files using the default descriptor

CA This allows data from different user files to be kept separate.

User files can also be processed directly fromNatural but the associated DDM may not be modified.

User files are defined as private files in Natural Security and automatically lifk¢&8N Super
Natural users may not use each other’s user files unless the administrator authorizes them to. Users and
administrators can not copy transactions with Destination USERFILE.

Because of the interdependency between the DDMs and the data in the personal database, the following
conditions must be fulfilled if you want to move them to another physical database:

® The Master DDM must be catalogued with DBID=0

® The Personal Database must have an Adabas file number which can also be used in the new
environment

The Personal Database is also used to store Notepad data, runtime error information and information of
the DDM Check on Modify functionality.

For an overview of the Personal Database, see the following diagram:
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Error Logging

The Error Logging facility allows you to store environment information at the time of your error directly
and without a delay.You can use the prog@ELOG, stored in theSuper Natural libra®y SSN to

maintain the logging utility and review runtime errors. Error Logging is designed to report Natural System
Errors.

This section covers the following topics:
® Possible Errors
® Listing Error Reports
® Showing Error Reports
® Deleting Error Reports
® Printing Error Reports
e Maintaining Error Reports
e Migrating old Error Reports

If you want to view the Error Logs you have to activate the Error Reporti8y#L.OG in the Library
SYSSN
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Possible Errors

The following errors are not user errors but may occur for

Technical Information

one of the following reasons:

Cause

Cure

System parameters are set too IBDRTSZE, printer size
etc)

Change system parameters

Response codes from DBMS eg. (NAT3009)

Inform users eg. using system user
exits

Syntax errors due to incorrect Super Natural code geners:

Inform Support

System errors due to incorrect Super Natural routines

Inform Support

Listing Error Reports

If you want to view the Error Reports you have to activate the Service-R&NIBEOG in the

LibrarySYSSN

» Invoke List of Error Reports

® Invoke the Service-Routif@NELOG out of the librar$gYSSN

The following screen appears:

17:02:54 *rxkk Super Natural ***** 2000-06-21
- Error Reporting and Analization - MELOG11
Code Function
L List Error Reports
D Delete Error Reports
M Maintain Error Reporting
? Help
Exit
Code ......c...... _
Library ........... *
Program Name ...... *
Date Time ......... 2000-06-21 *
YYYY-MM-DD HH:II:SS.T
Personal DB DBID .. 167__
Personal DB FNR ... 93____
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
HELP Exit Canc
4AA! 14,024
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Field Descriptions
Code
The following function codes are possible:

e |: Lists all Error Reports of the according selection criteria, consisting of Library, Program Name
and Date / Time.

e® D: Deletes all Error Reports of the according selection criteria, consisting of Library, Program Name
and Date / Time.

e M Maintains Error Reporting

?: Provides help concerning the Error Reports
® . : Terminates the Function
Library

Choose the library which Error Report you want to display. There are three ways to enter the Library
Name:

® Enter the complete Library Name

® Enter a*.

e Enter a part of the Library Name with a Wildcard (*,<,>)
Program Name

Choose the transaction whose Error Report you want to display. You can enter the program name as
describedabove

Date Time

Choose a Date / Time to display an Error Report. You can enter the Date / Time as dabonbed
The List Error Report Screen appears with the set of Error Reports according to your selection.
Personal DB DBID / Personal FNR

e Specify the database ID (DBID) and the file number (FNR) of the personal database whose logging
list you want to display. The default DBID and FNR depend on the setting of the parbRieEer.

List of Error Reports
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17:35:20 *rxxx Super Natural ***** 2000-06-21
- List Error Reports - MELOG21
Cmd Date/Time Err-No Library Program Line Stat User-ID
2000-06-21 * * * * *

_ 2000-06-21 15:50:23 3055 YPOR ILIST 0860 O POR
_ 2000-06-21 16:59:17 0082 YPOR IERROR 0350 O POR

Cmd’s are S (Show), D (Delete), P (Print)

You are on the last page

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit -- + Canc

Navigation
» To move Up / Down
1. UsePF6 to move to the first page.
2. UsePF8 to move one page forward.
» To Exit / Cancel
® ChooseExit orCancel to leave the transaction list and reach theError Reportmain screen.
Commands
Choose the required Error Report. There are three ways to process the Error Reports:
e Show: The selected Error Report is shown. For further informatiomossigow the Error Report
® Delete : The selected Error Report is deleted. For further informatido sieéete an Error Report
® Print : The selected Error Report is printed. For further informatiotogeent an Error Report
Field Descriptions
Date / Time

Date / Time, when the error occurred and the Error Report is written. You can enter the Date / Time as
describedabove
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Error-Number

Shows the number of the error that has occurred. You can enter the Error-Number as desavibed
Library

Name of the library where the error occurred. You can enter the Library as deabdlved
Program

Program that did flag the error. You can enter the Program name as desiiked

Line

The line number in the program where the error was identified.

Status

Additional information on the kind of error.

User-1D

User ID of the person who received the error. This information can be suppressed if desired (see section
Maintain Error Repor)s You can enter the User ID as descridsule

Showing Error Report

» To show the Error Report
e EnterS to show the Error Report

A window appears where the most important information concerning the error is displayed.
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Technical Information

17:51:44 Rk Super Natural ***** 2000-06-21

- Show Error Report - MELOG41
Error occurred at .. 2000-06-21 16:59:17 with UserID ........ POR
Error Number ....... 82 in Library ......... YPOR

Error Program ...... IERROR /Line..350 with Error Status .. O
Message Text:
Invalid command, or Subprogram NIX-DA does not exist in library.

Environment Information

Device Type ....... PC Operating System .. MVS/ESA
TP Monitor ........ COMPLETE
Product Versions:

Super Natural ... 3.3.1 System Files (DBID,File):
Natural ......... 3.1.3 PersonalDB ...... (167,93)
Predict ......... 4.1.1 FNAT ....cce (167,30)
CON-NECT ........ 0.0.0 FUSER ........... (167,32)
AOS ............. 0.0.0 FSEC ............ (167,30)
NSC ......c...... 0.0.0 FDIC ............ (167,15)

You are on the first page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF 7---PF8---PF9---PF10--PF11--PF12---
Print Exit + 4+ Canc

Navigation

» To print
® EnterPrint  (or PF2).

» To move Up / Down
1. UsePF6 to page to the first page.
2. UsePF8 to page one page forward.

» To Exit/ Cancel

® ChooseEXIT orCANCELo leave the report and reach theError Report List screen.

Error Report Descriptions

General Description

18:20:27 *xxx Super Natural ***** 2000-06-21

- Show Error Report - MELOGA41
Error occurred at .. 2000-06-21 16:59:17 with UserID ........ POR
Error Number ....... 82 in Library ......... YPOR

Error Program ...... IERROR /Line .. 350 with Error Status .. O
Message Text:
Invalid command, or Subprogram NIX-DA does not exist in library.
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Listing of the major information at the time when the error occurred

Field Description

Error occurred at |Date / Time when the error occurred.

Error Number Error-key

Error Program Program that did flag the error.

Line Program line where the error was found.
Message Text Text, that informs about the error reason.
User ID User ID that received the error.

Library Library name where the error occurred.
Error Status The following entries are possible:

® C (Command Processing Error)
® L (Logon Error)

® O (Object Time Error)

® S (Non-correctable Syntax error)

® R (Error on Remote server (in conjunction with Natural RPC)

® Pres$PF8 for more information

Environment Information

10:19:19 *kkk Super Natural **++* 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ -
Error Number ....... 932 in Library ......... NEWSN
Error Program ...... SN1110 /Line..1510 with Error Status .. O
Message Text:

Program version error.

Environment Information

Device Type ....... PC Operating System .. MVS/ESA
TP Monitor ........ COMPLETE
Product Versions:
Super Natural ... 3.3.1 System Files (DBID,File):
Natural ......... 3.13 PersonalDB ...... (167,93)
Predict ......... 411 (167,30)
CON-NECT ........ 000 = FUSER...... (167,32)
AOS ............. 0.0.0 (167,30)
NSC ...ccvenee. 0.0.0 (167,15)

You are on the first page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Print Exit + o+ Canc
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Default listing of data from the error environment. This list consists ofNatural environment variables.

® Pres$PF8 for more information

Natural Parameter Information

10:19:19 *xxx Super Natural ***** 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ -
Error Number ....... 932 in Library ......... NEWSN
Error Program ...... SN1110 /Line.. 1510 with Error Status .. O
Message Text:

Program version error.

Natural Parameter Information (1)

Term.Control Character (CF) .. ? 65 Limit Error (LE) ............. OFF
Decimal Character (DC) ....... . 4B Line Size (LS) ....c..cceuu. 80
Default Format (FS) .......... ON  Print Mode (PM) .............. RP
Help Character (HI) .......... ? 6F Page Size (PS) .....c......... 23
Input Assign (1A) ............ = 7E Structured Mode (SM) .........

Input Delimiter (ID) ......... , 6B Zero Division (ZD) ........... ON
Input Mode (IM) .............. F Zero Printing (ZP) ........... ON

You are on the first page

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12--
Print Exit - -+ ++ Canc

Information of Natural Parameters that are set by starting the session. Some information is displayed
additionally in HEX characters. For more information concerning Natural Parametétaisaé
Installation and Operationdocumentation.

® Pres$PF8 for more information
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10:19:19 *kkk Super Natural ***** 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ -
Error Number ....... 932 in Library ......... NEWSN
Error Program ...... SN1110 /Line .. 1510 with Error Status .. O
Message Text:

Program version error.

Natural Parameter Information (2)

Max. CPU Time (MT) ........... 6000 Automatic LOGON (AUTO) ....... OFF
Max. Program Calls (MAXCL) ... 0 Database Updating (DBUPD) .... ON
Nat. System Commands (NC) .... OFF Date Format (DTFORM) ......... I
Wait on Hold (WH) ............ OFF

Processing Loop Limit (LT) ............ 99999999
Max. DBMS Calls between 10 (MADIO) .... 0
Read Only System Files (ROSY).......... OFF

You are on the first page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF 7---PF8---PF9---PF10--PF11--PF12---
Print Exit R Canc

® Pres$PF8 for more information

Natural System Variables Information

10:19:19 *kkk Super Natural ***** 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ -
Error Number ....... 932 in Library ......... NEWSN
Error Program ...... SN1110 /Line .. 1510 with Error Status .. O
Message Text:

Program version error.

Natural System Variables Information

*DATA e 0 *LOG-LS ... 132
*HARDCOPY .............. DAEPRTAD  *LOG-PS ................ 23
*INIT-ID ... DAEFTCB9  *PAGESIZE .............. 24
*INIT-PROGRAM .......... NAT31 *PE-KEY ..o ENTR
*INIT-USER ............. *PE-NAME ...............
*LANGUAGE .... *STARTUP ............... MENU
*LINESIZE .............. *STEPLIB ............... SYSTEM

You are on the first page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF 7---PF8---PF9---PF10--PF11--PF12---
Print Exit R N Canc

® Pres$PF8 for more information
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Natural Stack Information

10:19:19 ek Super Natural **+* 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ -
Error Number ....... 932 in Library ......... NEWSN
Error Program ...... SN1110 /Line.. 1510 with Error Status .. O
Message Text:

Program version error.

Natural Stack Information

Stack Level 1:
Type ...... Stack Empty
Contents ..

Stack Level 2:
Type ...... Stack Empty
Contents ..

Stack Level 3:
Type ...... Stack Empty
Contents ..

You are on the last page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Print Exit - - Canc

Information on the Natural Stack status.

The Natural parameter information, theNaturalsystem variables and theNaturalstack information can be
suppressed if desired (see sedamtain Error Reporting ).

Deleting Error Reports
This command enables you to delete an Error Report.
» To delete an Error Report
1. EnterD (Delete) beside the transaction name in the list of Error Reports.

A window appears, where you have to confirm the delete.
You can also mark multiple Error Reports to delete.

Or:

EnterD (Delete) within the Error Logging main screen and choose the desired Error Reports out
there.
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10:22:11 Rk Super Natural ***** 2000-09-20
- List Error Reports - MELOG21
Cmd Date/Time Err-No Library Program Line Stat User-ID
2000* * * * *
_ 2000-07'! Confirm Delete I -
_ 2000-07! ! -
d 2000-07! 1 Error Reports will be deleted. I -
_ 2000-07! ! -
_ 2000-07! Please enter 'Y’ to confirm: Y -
_ 2000-07! ! -
2000-07

2000-07-20 15:30:26 0932 NEWSN SN1110 1520 O
2000-07-20 16:13:08 0932 NEWSN SN1110 1520 O -
2000-07-20 17:07:42 0932 NEWSN SN1110 1590 O -
2000-07-21 07:56:15 0261 YCF  TOOXX01 0010 S -
2000-07-21 10:41:07 0932 NEWSN SN1110 1590 O -
2000-07-21 10:41:08 0082 SYSSN SNREST 0000 C -
2000-07-21 10:41:08 0082 SYSSN SNREST 0000 C -
_ 2000-07-21 10:41:08 0082 SYSSN SNREST 0000 C -
Cmd’s are S (Show), D (Delete), P (Print)

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit Canc

2. EnterY if you want to delete the Error Report.

The Error Report is deleted now.
Printing Error Reports
This command enables you to print an Error Report.

» To print Error Reports
1. Select Error Reports to be printed.
2. EnterPrint orPF2.

The information of the Error Report is composed on one page and printed on the printer you have
choosen.

Maintaining Error Reports
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18:10:14 *kkk Super Natural ***** 2000-06-21
- Maintain Error Reporting - MELOGS811

Code Function
E Enable Error Reporting

D Disable Error Reporting

S Set Error Reporting Options
M

?

Migrate old Error Reports
Help
Exit

Code .. _

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
HELP Exit Canc

These functions help you to maintain the Error Reports. They are deatwlvetiecause the are
prerequisites for error logging.

Enable Error Reporting
You have to enable Error Reporting in your user file to receive the Error Reports.
» To enable Error Reporting

1. EnterE and press Enter.

The following window appears:

119



Technical Information Super Natural Version 3.3.1 Administration

10:31:24 *rxxk Super Natural ***** 2000-10-05
- Maintain Error Reporting - MELOGS811

!
Enable Error Logging !
I

The Error Reporting will be enabled now. !
I

Please enter 'Y’ to confirm: Y !
!

Exit

Code .. E

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit Canc

2. EnterY and press Enter.
TheError Reporting facility is enabled
Disable Error Reporting

If you do not want to log Error Reports further on, disable this facility. All existing Error Reports are
deleted and the future occurring errors are not reported.

» To disable Error Reporting
1. EnterD and press Enter.

The following window appears:

120



Super Natural Version 3.3.1 Administration Technical Information

10:27:53 Rk Super Natural ***** 2000-10-05
- Maintain Error Reporting - MELOGS811

!
Disable Error Logging !
I

The Error Reporting will be disabled now !
and All Error Reports will be deleted. !
I

Please enter 'Y’ to confirm: N !
!
!

Code .. d

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit Canc

2. EnterY and press Enter.
The Error Reporting facility is disabled and all stored Error Reports are deleted.
Set Error Reporting Options
This window allows you to specify how Super Natural Errors are reported.
» To set Error Reporting options
e EnterS and press Enter.

The following window appears:

Set Error Reporting Options

Online Error Display
with Error Message Text .......... N (Y/N)

Record Error Report Data
with Natural Session Parameters .. Y (Y/N)
with Natural System Variables .... Y (Y/N)
with Stack Data/Commands ......... Y (Y/N)

Store User ID
with Error Reports ............... N (Y/N)

These options influence the online error messaging and thge date stored in an Error Report as you
define them here. You can modify them to your needs. Be aware that the options you set here,
concern your whole Super Natural system and are not user-specific.
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Online Error Display with Error Message Text
® Defines if the error is displayed online with message text or just with the error number.
Record Error Report Data withatural Session Parameters

® A selected number of Natural session parameters are logged with the values they have at the time
when the error occurs.

Record Error Report Data with Natural System Variables

® A selected number of Natural system variables are logged with the values they have at the time when
the error occurs.

Record Error Report Data with Stack Data/Commands

® The first three levels of stacked data or commands are logged.
For further information on these options, dixural Installation and Operation Documentation
Store User ID with Error Reports

Defines if the User ID of the user who receives the error is displayed on the Error Report.

Migrating old Error Reports

If you have Error Reports that are logged by Super Natural versions earlier than 3.3.1, they will not be
displayed with the new Error Reporting Facility. You have to migrate them to work with them in future.
The old Reports will be structured according to the new Error Reporting facility. After the migration they
are available on the List Error Report screen.

» To migrate old Error Reports
1. EnterMand press Enter.

The following window appears:

!
Confirm Migration !
!
211 Error Reports will be migrated !
to new Error Report Format. !
!
The old Error Reports will be deleted !
and the old Log File will be closed. !
!
Please enter 'Y’ to confirm: y !

2. Entery.

The old Error Reports are migrated. The old Error Reports will be deleted and the old log file will be
closed. This means that the Error Reports can not be viewed with an earlier ve&\ELAIG if
you use a previous version ofSuper Natural and the current simultaniously.
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DDM Check on Modify

The option DDM Check on Modify allows you, to compare the field structure of the transaction with the
current field structure of the DDM used. The result decides wether the current DDM-field structure can be
adopted or whether no adaption is possible.

This section covers the following topics:
® Results of Checking
® Criteria of Checking
e Change of References
e Modes of DDM Check on Modify
® Enable DDM Check on Modify
® Phases of DDM Check on Modify

Furthermore there is the option SNTALOG to obtain a status report, where all information concerning
deviations is listed.

Results of Checking
The following graph shows the order of events of DDM Check on Modify.

Note:
DDM Check on Modify is only feasible, if the option DDM Check on Modify is set to "yes". This option
can be set in the user-profile, file-profile and superfile-profile.
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DDMs are unchanged

No deviations are located between the field structure of the transaction and that of the DDM. No Status
Report is written and no confirm-window is displayed.

Transaction is adaptable

Some deviations are located between the field structure of the transaction and that of the DDM, but they
are automatically adaptable. A Status Report is written (if activated) and the confirm-window is displayed.

Transaction is not adaptable

Some deviations that are located between the field structure of the transaction and of the DDM, that
cannot be adapted automatically. A Status Report is written (if activated) and the confirm-window is
displayed.

Transaction corrupt, inconsistent or DDM not available

The transaction is detected as corrupt or inconsistent or not all DDMs used are available. A Status Report
is written and a confirm-window is displayed.

Old Transaction

The transaction cannot be processed, because it was developed with a Super Natural Version before - 311.
First the transaction has to be migrated separately without the option DDM Check on Modify. Then it can
be adapted. No Status Report is written, but a confirm-window is displayed.

Criteria of Checking

All transaction that usPata Selection = Full Screen or Data Maintenance Types
(Add, Update etc.) are checked with the option DDM Check on Modify.

Exeption:
Transactions that use other data selection modes ignore the option DDM Check on Modify although they
use lookup files.

Fields checked

Primary / All fields of the new DDM are loaded into the transaction. A comparison is madle
Secondary |only between the fields of the Transaction and the DDM-Structure that are listefl in
Files the worksheet of the transaction. The remaining fields are updated without a
DDM-fieldstructure check.

Lookup Files | Only used fields selected in the transaction are loaded from the DDM and compared
with the transaction fields.

User Fields |User fields and system variables are only checked to see if the field reference has
changed.
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What Field Properties are Checked?

Technical Information

Fieldname and

Criteria of comparison between the new structure of the DDM and the str|

Licture

within the DDM. Possible meanings: Array, Multiple, Periodic, Multiple in

Filenumber of the transaction. Fieldname and filenumber must be identical (primary flle
must be 1, secondary file must be 2, lookup file must be 3 or higher).Othgrwise
it is assumed that the field is deleted.

Database-Referenc| If the Database-Reference has changed (if it exists) the field can not be
allocated any more.

Format A change of format is an essential change that can cause errors by procgssing
the transaction.

Level A change of level indicates that the field is assigned to another group or fhat is
no longer assigned to any group.

Length If the length decreases, the values that were assigned to that field, may not fit
any more.

Decimal-Places If the length decreases, the values, that were assigned to that field, may hot fit
any more.

Descriptor Type A change of the descriptor type indicates that a field obtains a different
meaning within the DDM. Possible meanings: Super-Descriptor,
Sub-Descriptor, Phonetic-Descriptor or Non-Descriptor.

Array Type A change of the array type indicates that a field obtains a different occurrence

Periodic, Elementary Field.

Change of References

New Fields in the DDM

If new fields join the DDM, the transaction field-references are moved. All following database fields,
system fields and user fields get new references. These changes will be updated automatically in all
functions of the transaction.

Deleted Fields in the DDM

If fields in a DDM are deleted, transaction field-references are moved. These new references are updated

in all functions of the transaction.

Modes of DDM Check on Modify

A transaction check can lead to the following results:

® no update possible

® automatic update is processed

® transaction is processed without update
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trars action corrupt

General error |—_| CCr b ot awail able |

_| Trans action incons stent |

Mo update pozsible

_| Field used & notidentifiable. Filename and file number have to be identical.

_| [ratabase-Reference has changed. |

Error

_| Foarmat has changed. |

_| Array-Type has changed. |

_I Lirk field for a lookup file key field i not identifiable.

_| Length has decreased. |

_| [Lecimal places have decreased. |

_| Crescriptor type has changed. |

Transaction up date possible _| Field selected, but not used (in the workzheet) & not identifiable.

—I Field-Reference has changed. |

_| Lewel has changed. |

_| Irfo rmation I—_| Length has increased. |

_| [Lecimal places have increased. |

_| Loaok up file field, not used and notselected, i not identifiable.

| Tranz action update processed l l Ok l l Successfully updated |

Enable DDM Check on Modify

The option DDM Check on Modify is set in the Maintenance section of Super Natural. The place where
the option is set decides the consequences:

user profile all transactions of this user will be checked

file profile all transactions of all users, that use this file as primary- or secondary file, willfbe
checked

super-file all transactions will be checked, that use this super-file

profile

The following section describes, how you can proceed a transaction in spite of a changed DDM. However
this update is not possible, if a General Error or an Error (see Verification-Level) appears.

Phases of DDM Check on Modify
The functionality is divided into two phases:

1. Get the current DDM field-structure, compare it against the transaction field-structure and identify
differences.
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2. Update the references in the functional parts of the transaction. The updated field-list is provided in
the worksheet.

Update possible

The following window appears:

+ Confirm +

I Changes in the data structure of one or !

I more files used in the transaction are !

! detected. !

I _ Update Data Structure(s) !
and Enter Worksheet !

|

I _ Leave Transaction !
| |
+

» Proceed the transaction-update
1. Choose the option Update Data Structure(s) and Enter Worksheet
The worksheet of the transaction appears.
2. Choose the option Leave Transaction if you do not want to proceed with the transaction now.
The update of the data structure(s) is canceled. A Status Report (if enabled) is written.
Conclude DDM Check on Modify

e |f you conclude the transaction wibep ,save orrun the updated field-description is saved into
the transaction.

e |f you abandon the transaction withncel or menu, the transaction is dropped.
No Update possible

No Update is possible if the DDM is changed so, that a system error or a error (see Modify-Options)
occurs. The following screen will be displayed.

+ Confirm +

I Changes in the data structure of one or !

I more files used in the transaction are !

! detected. !

! The differences between the former and !

! the current data structure can not be

! resolved automatically.
|

_ Leave transaction

|

|

+
t

» To leave the transaction
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® Choose Leave Transaction.
A Status Report (if enabled) is written. It gives the reason for not updating the transaction.
Change Transaction Manually to enable the Update
» Change Transaction manually to enable the update of the data structure
1. You may switch off the option DDM Check on Modify.

2. Enter the transaction and remove the field usage that prevented the automatic update according the
information provided within the Status Report (in enabled).

3. Modify the transaction again with the option DDM Check on Modify.

Status Reports
This section covers the following topics:
e Displaying Status Reports
® Browsing Status Reports
® Deleting Status Reports
® Printing Status Reports

A Status Report describes the Status of a transaction concerning the changed DDM. For each transaction
that was modified using the option DDM Check on Modify, one Status Report is provided. It contains the
current status of the transaction and shows finally, whether the transaction was successfully updated and if
it was saved with the new DDM field structure.

If you want to view the Status Reports you have to activate the Service-RBNII#OG in the
Library SYSSN Further information see ttf&uper Natural Installation documentation

Displaying Status Reports
You can display the current Status Report out of a list of all available Status Reports.
» Invoke List of Status Reports

® Invoke the Service-Routif@NTALOG out of the librargYSSN

The following screen appears:
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11:32:21 Rk Super Natural ***** 1999-04-16
- Transaction Status Reports - MTALOG11

Code Function

L List Transaction Status Reports
D Delete Transaction Status Reports

? Help

. Terminate
Code .............. L
Library ........... ypor____ (with library prefix)
Transaction Name .. I* (with transaction prefix)
Date Time ......... *

YYYY-MM-DD HH:II:SS.T
Personal DB DBID .. 167__
Personal DB FNR ... 93____

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
HELP Exit Canc

Field descriptions
Code

The following function codes are possible:

L Lists all Status Reports of the according library.

D Deletes the marked Status Reports

? Provides help concerning the Status Reports
® . Terminates the function
Library

Enter the library name with the associated prefix. A prefix is always placed in front of the library name.
There are three ways to enter the library name:

e Enter the complete library name

e Entera* (the List Transaction Status Report Screen appears where you can choose the appropriate
Status Report)

® Enter a part of the library name with a wildcard (*,<,>)
Transaction Name

Choose the transaction whose Status Report you want to display. For the way to enter the transaction
name see the descriptiabove
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Date Time
® Choose a Date / Time to display a Status Report. You have three ways to enter the Date / Time:
® Enter the complete Date / Time (YYYY-MM-DD HH:1I:SS.T)

® Enter a* (the List Transaction Status Report screen appears where you can choose the appropriate
Status Report)

® Enter a part of the Date / Time with a Wildcard (*,<,>)
Personal DB DBID / Personal FNR

e Specify the database ID (DBID) and the file number (FNR) of the personal database whose logging
list you want to display. The default DBID and FNR depend on the setting of the parbRieEer.

List of Status Reports

14:05:27 ek Super Natural **+ 1999-05-28
- List Transaction Status Reports - MTALOG21
Cmd Library Program Date/Time Level Status User-ID
* * * *

CSAMPLE IOTESTO03 1999-04-29 14:57:20.0 | Reference changed -QE
CSAMPLE IOTESTO05 1999-04-28 17:35:30.4 | Reference changed -QE
YCF IAAAAA 1999-04-30 15:28:46.2 | Reference changed CF

YCF IAAA1  1999-04-23 13:50:15.6 | Reference changed CF

YCF IAAA2  1999-04-23 15:08:43.3 F Successfully updat CF

YCF IAAA3  1999-04-23 15:11:17.2 F Successfully updat CF

YCF IAAA4  1999-04-23 15:13:13.5 F Successfully updat CF

YCF IAABC  1999-04-29 14:37:07.3 W Length less CF

YCF IAAB11 1999-05-03 16:57:17.8 | Length greater CF

YCF IAAB4  1999-04-29 14:37:48.8 F Successfully updat CF

YCF IAAB4SEL 1999-04-29 14:41:25.3 F Successfully updat CF
YCF IAABSSEL 1999-05-03 16:56:58.6 E Not ident.(used) CF

YCF IASDF  1999-05-17 11:36:20.6 W Length less CF

YCF INEU3  1999-05-10 13:34:38.4 | Reference changed CF

_ YCF INEU4  1999-05-10 10:57:45.6 F Successfully updat CF

Cmd’s are B (Browse), D (Delete), P (Print)

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit -- + Canc

Navigation
» To move Up / Down
1. UsePF6 to move to the first page.

2. UsePF8 to move one page forward.

» To Exit/ Cancel

® ChooseExit orCancel to leave the transaction list and reach the Status Report main screen.
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Commands
® Choose the required Status Report. There are three ways to process the Status Reports:

® Browse : The selected Status Report is browsed. For further informatido beawse the Status
Report

® Delete : The selected Status Report is deleted. For further informatido seéete a Status Report
® Print : The selected Status Report is printed. For further informatioto ggent a Status Report

Field Descriptions

Library

Name of the library where the Status Report is stored.

Program

Transaction name of the associated Status Report.

Date / Time

Date / Time, when the transaction is processed and the Status Report is written.

Level

Possible levels: finished, information, warning, error, general error.

Status

This field shows detailed information of the reason why the Status Report was written. The worst case is
displayed.

User-ID
User ID of the person who has processed the transaction.
Browsing Status Reports
Browse Status Report
» To browse the Status Report
e EnterB to browse the Status Report

A window appears where the most important information of the processed Transaction with changed
DDM is displayed.

131



Technical Information Super Natural Version 3.3.1 Administration

13:40:15 Rk Super Natural ***** 1999-04-28

- Browse Transaction Status Report - MTALOG31
Transaction ..... 1Z02CRU Verified at .. 1999-04-28 13:33:46.7
Library ......... YPOR by .. POR
Warning ......... Length less

Primary File .... -QE-TST-21
Secondary File .. -QE-TST-24

Cmd Field Verification Field Name Field Type Format

_ Length less START-TIME Primary N3

_ Reference changed ID-YACHT Primary N8

_ Reference changed CHARTER-CRUISE Primary  Group

_ Reference changed ID-CONTRACT Primary P 6

_ Reference changed START-DATE-DESTINATION Primary A 49
_ Reference changed YACHT-ID Secondary N 8

_ Reference changed YACHT-NAME Secondary A 30

_ Reference changed YACHT-BRANCH Secondary A1l

Cmd is S (Show Details)

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Print Exit - + Canc

Navigation
» To print
e EnterPrint and the current Status Report is printed.
The Status Report is printed
» To move Up / Down
1. UsePF6 to page to the first page.
2. UsePF8 to page one page forward.
» To Exit / Cancel
® ChooseExit orCancel to leave the transaction list and reach the status report list.

» To Show Details

1. Select the field of the transaction you want to get further information about an8 gjstesw

details)
To view multiple fields in detail:
2. Mark the required fields witB

3. Press Enter.
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4. Page through the selected field descriptions RiKB.
After you have paged through all field descriptions, you again reach the browse screen.

Status Report Descriptions
Transaction
Name of the current transaction with prefix.
Library
Name of the library with prefix, where the transaction is saved.
Finished / Information / Warning / Error / General Error

Finished / Information / Warning / Error / General Error are possible status of the transaction. This field
shows detailed information of the reason why the Status Report was written. The worst case is displayed.

Primary File

Name of the primary file

Secondary File

Name of the secondary file if defined.
Verified at ... by

Date / Time when the transaction was accessed last with the option DDM Check on Modify and user ID,
which performed the DDM check.

Note:
Further field descriptions see show details.

» To view the detailed description of single fields of the transaction
® EnterS (show details)
You receive a detailled description of the choosen field.

Note:
You can choose multiple fields simultaneously.
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13:42:14 *rxxx Super Natural ***** 1999-04-28

- Show Transaction Status Report - MTALOG41
Transaction ..... 1Z02CRU Verified at .. 1999-04-28 13:33:46.7
Library ......... YPOR by .. POR
Warning ......... Length less

Primary File .... -QE-TST-21
Secondary File .. -QE-TST-24

Detail Information for Field ID-YACHT

Verification ...... Reference changed --- In Use with ---
Field Type ........ Primary Link Field

Format ............ N8

Descriptor Type ... Descriptor

Array Type ........

Field Reference ... AL
DB Reference ...... CT
Linked with File ..

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Print Exit Canc

Navigation
» To print
® EnterPrint
The current Status Report is printed.
» To cancel
® ChooseCancel to leave the Show Details screen and reach the browse screen immediately.
» To exit

® ChooseExit to page through the selected field descriptions (if you have chosen multiple fields).
After you have paged through the field descriptions, you reach the browse screen.

Detail Information for a field

Verification

Result of DDM Check on Modify: reason for reporting for a field.
File Type

The following entries are possible:

e primary file
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® secondary file

® |ookup file

® system variable

® dynamic input field
Format
Field format and length.
Descriptor Type
The following entries are possible:

® empty

® descriptor

® super-descriptor

® sub descriptor

phonetic descriptor
® hyper descriptor
Array Type
The following entries are possible
® empty
® periodic group
e multiple field
o multiple field within a periodic group
Field Reference

Unique Reference (two letters) of this field within the transaction. The reference before DDM Check on
Modify is shown.

DB Reference
Adabas database reference.
Linked with File

Filename of the lookup file, which is linked with the current file.
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In Use with
List of transaction functions where the current field is used.
Possible functions are:
® Display
e Control Break
® Redefinition on Field
e |Interfield Arithmetic
® System Function
® Selection
e Calculation
® |ogics
® Tabular
e Graphics
® Layout (report)
® User Exit
® Link/ Join Field

® Connect Text Link

Deleting Status Reports
This command enables you to delete a Status Report.
» To delete a Status Report
1. EnterD (Delete) beside the transaction name in the list of Status Reports.

A window appears, where you have to confirm the delete.
You can also mark multiple Status Reports to delete.

I Delete Transaction Status Report IZ02CRU !
! of library YPOR !

I Please enter 'Y’ to confirm: N !

! !

+ +
T T
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2. EnterY if you want to delete the Status Report.

The Status Report is deleted now.
Printing Status Reports
This command enables you to print a Status Report.

» To print a Status Report

1. EnterP (Print) beside the transaction name in the list of Status Reports.

A window appears, where you have to confirm printing.
You have also the possibility to mark multiple Status Reports to print.

I Print Transaction Status Report 1Z02CRU !
! of Library YPOR !

I Please enter 'Y’ to confirm: N !

! !

+ +

2. EnterY, if you want to print the Status Report.

The Status Report is printed now.

Super Natural RPC Service Functionality
This section covers the following topics:

® |Introduction

® Hints and Limitations

® Dynamic Input Fields within the RPC Service

® Generate an RPC Service (Server Side)

® Resulting RPC Service Source

® Create the Client Side Parameters

Introduction

Technical Information

Remote procedure call (RPC) techniques establish a framework for communication between server and
client systems that can be collocated on the same computer or based on a network of identical or
heterogeneous machines and operating systems. The Natural Remote Procedure Call (RPC) facility
enables a client Naturalprogram to issu@fd LNATstatement to invoke a subprogram in a server

Natural. The Naturalclient and server sessions may run on the same or on a different computer.
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Natural RPC exploits the advantages of client server computing. In a typical scenario, Natural on a
Windows client computer accesses server data (using a middleware layer) from a Naturalon a mainframe
computer. The following advantages arise from that:

® The end user on the client can use aNaturalapplication with a graphical user interface.
® A large database can be accessed on a mainframe server.
® Network traffic can be minimized when only relevant data are sent from client to server and back.

The RPC (Remote Procedure Call) service is designed to produceSuper Natural services for distributed
working.Super Natural RPC generates a Natural RPC subprogram from a Super Natural Transaction. This
NaturalRPC subprogram represents a Naturalobject that is executable in any Natural RPC environment. A
NaturalRPC service (subprogram) that was generated from Super Naturalis executable via a Natural RPC
server. The RPC client can be in a network or on a local system and is completely independent.

NT (PC), UNIX, Mainframe Mainframe

fenerates

Automatic Client Stub

RPC Client RPC Server
Service Routine Service Routine

For further information about RPC sWatural RPC Documentation.

Hints and Limitations

The following points provide information on the RPC service and show which transactions are not
supported:

e Before you can start using the RPC service the administrator has to set it up in the user profile.
e The RPC service is generated in Natural Reporting Mode.

® The RPC service can be used as any Natural RPC service. It contains no Super Natural-specific
information.
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e For each RPC service generation, the transaction is automatically saved with the Super Natural
commandkeep .

® You can only us®eport Transactionsto generate the RPC service,Data Maintenance
Transactions

® Transactions, defined with report tyfabular or Connect are not supported by the RPC services.

® The RPC service Objects are generated to be used with automatic Natural RPC execution. This
requires to set the RPC parameteAtdI ORPC=QNFor further information see tidatural
DocumentatiorsectiofiRemote Procedure Call > Automatic Natural RPC Execution

® The library type is important to meet the requirements of the RPC logon feature that is set on the
client side. For further information sdkatural DocumentatiosectionRemote Procedure Call >
Logon Features

Dynamic Input Fields within the RPC Service

You can process more dynamic RPC services by using the Super 8iataraic input fieldsHerewith
the client application defines the selection values at execution time when calling the RPC service.

This requires an additional input structure to be generated for the RPC service. It must be part of the client
interface.

Generate an RPC Service - Server Side

You can use any transaction (except the documented limitations) of your worksheet to proceed the RPC
service.

» To generate an RPC service
1. Select a transaction out of the transaction list witM@BIFY(mg command.
The worksheet appears.
2. EntertGENERATE RP@nto the command line.
3. Press Enter.

The following window with the default settings appeatrs:

RPC-Service Generation

The RPC Service will be stored with
Object Name ........... RPCSMPL1
in Library ............ NSNSAMPL
with Generation Mode .. Direct
and Record Limit ...... 545

_ Generate with these options
X Change options before generation
_ Modify Transaction
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4. Specify how you want to proceed:
Generate with these options

The generation process starts. If the service object to be generated already exists, confirm the
replacement in the appearing window.

Change options before generation

Modify the RPC service options before starting the generation process. TheModify Generation
Options window appears.

Modify Transaction

Return to the preceding screen to modify the transaction.
5. SelectChange Options before Generation
6. Press Enter.

The following screen appears:

RPC-Service - Modify Generation Options

RPC Service Object Name ........ RPCSMPL1
Library ............ NSNSAMPL

Generation Mode ................ D Direct
Limit of Result Records ........ 545
(Max. possible Result Records .. 545 )

7. Fill in the required information.
RPC Service Object Name

Name of the RPC service Object to be generated. Depends on the user options and can be pre-defined
by the administrator.

Library

Library of the RPC service Object to be stored. Depends on the user options and can be pre-defined
by the administrator.

Generation Mode

Direct or Context. Defines how the Generation will be processed. For further information see section
Generation Modes

Limit of Result Records / Max. possible Result Records

Result record handling. For further information see seRésult Data Limitations.
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8. Press Enter.
The RPC service Object has been generated and is ready to use.
You can control your RPC service by looking at the Natural-Code.
» To confirm the replacement of an RPC service

If you want to generate the same RPC service object twice you have to confirm the replacement of the
first.

1. Specify the RPC service Object name in the RPC Optionswindow and press Enter.

The following window apprears:

Confirm Replace RPC Service !
!
The RPC Service RPCSMPL1 !
in Library NSNSAMPL !
does already exist. !
The object will be replaced now. !
!
Enter Y to confirm: Y !

2. Confirm the replacement by enterii@nd press Enter
Result Data Limitations
Direct Mode
The number and the length of fields are relevant for the number of records!

Example selected result data:

#FIELD - A N 8
#FIELD - B Al
#FIELD - C A 20
#FIELD - D A 20

® results in a record length of 49 Byte
® maximal parameter buffer is 30 KByte

® results in a maximal number of 612 records
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Context Mode

The largest field length is relevant for the number of records in the context area (intermediate storage).
The number of records retrieved with one client call has the same limitation as explained in direct mode
but multiple calls can be performed in the context mode.

Example selected result data:

#FIELD - A N 8
#FIELD - B Al
#FIELD - C A 20
#FIELD - D A 20

e largest field length is 20 Byte
e maximal array size for a field in the context area is 32 KByte

® results in a maximal number of 1638 records

Resulting RPC Service Source

The following section gives you an insight into the source of a generated RPC service, explains the single
sections and introduces the naming conventions for input and output parameters.

Overview of the Source
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> >+ Subprogram RPCSMPL2 Lib NSNSAMPL
Top ..t lo+..20.+.3 444056 T
0010 * *ereemmesceniers Super Natural - RPC Service Routing# esssstcsiens
0020 *
0030 * Subprogram: RPCSMPL2
0040 * Author  : Super Natural
0050 * Date  : 2000-10-09
0060 *
0070 * NSN RPC Identification Area - do not touch the "* NRIA.-lines below
0080 *
0090 * NRIA. RPC YCF  IA-SMPL2200010091006048200010091001128CF
0100 *
0110 *
0120 DEFINE DATA PARAMETER
013001 #CONTROL
0140 02 #RETURN (N4)
0150 02 #MORE (L)
0160 02 #LIMIT (N10)
0170 02 #CT-RES (N10)
0180 02 #CT-POS (N10)
0190 02 #CT-PAGE (N5)
0200 02#MAX  (N5) 0210 01 #INPUT
0210 01 #INPUT
0220 02 #BI_DY_NAME-START (A20)
0230 02 #BJ_DY_NAME-END (A20)
0240 01 #OUTPUT (1:V)
0250 02 #AF_PRI_FIRST-NAME-1 (A20)
0260 02 #AE_PRI_SURNAME (A20)
0270 02 #AL_PRI_STREET-NUMBER (A20)
0280 02 #AN_PRI_ZIP-CODE (A10)
0290 02 #AO_PRI_CITY (A20)
0300 02 #AM_PRI_COUNTRY (A3)
0310 *
0320 CONTEXT
0330 01 #AF_CTX (A20/1638)
0340 01 #AE_CTX (A20/1638)
0350 01 #AL_CTX (A20/1638)
0360 01 #AN_CTX (A10/1638)
0370 01 #AO_CTX (A20/1638)
0380 01 #AM_CTX (A3/1638)
0390 END-DEFINE
0400 *
0410 SET GLOBALS LE=OFF
0420 MOVE 1638 TO #CONTROL #LIMIT
0430 RESET #LOOP-END(L) #CONTROL.#RETURN
0440 REPEAT UNTIL #CONTROL.#MORE OR #LOOP-END /* Data retrieval loop
0450 MOVE TRUE TO #LOOP-END
0460 RESET #LT-T(P10)
0470 #CT-OUT(P10)
0480 #CT-MAX(P7) = 1638
0490 MOVE #BI_DY_NAME-START TO #BI (A20)
0500 MOVE #BJ_DY_NAME-END TO #BJ (A20)
0510 PRI. FIND (1639 ) SAG-TOURS-E-PERSON
0520 WITH SURNAME = #BI THRU #BJ
0530 SORTED COUNTRY SURNAME
0540 ADD1TO#LT-T
0550 IF#LT-T > 1638 DO
0560 MOVE 12 TO #CONTROL #RETURN
0570 ESCAPE BOTTOM DOEND
0580 * Start: Store parameter
0590 ADD 1 TO #CT-OUT
0600 IF #CT-OUT GT #CT-MAX DO
0610 SUBTRACT 1 FROM #CT-OUT
0620 MOVE 16 TO #CONTROL #RETURN
0630 ESCAPE BOTTOM DOEND
0640 MOVE FIRST-NAME-1(PRI.) TO #AF_CTX(#CT-OUT)
0650 MOVE SURNAME(PRI.) TO #AE_CTX(#CT-OUT)
0660 MOVE STREET-NUMBER(PRI.) TO #AL_CTX(#CT-OUT)
0670 MOVE ZIP-CODE(PRI.) TO #AN_CTX(#CT-OUT)
0680 MOVE CITY(PRI.) TO #A0_CTX(#CT-OUT)
0690 MOVE COUNTRY(PRI.) TO #AM_CTX(#CT-OUT)
0700 * End: Store parameter
0710 LOOP (PRI.)
0720 LOOP /* Data retrieval loop
0730 IF NOT #CONTROL.#MORE MOVE #CT-OUT TO #CONTROL.#CT-RES
0740 * Start: Retrieve from context
0750 RESET #CONTROL.#CT-PAGE #CONTROL.#MORE
0760 REPEAT
0770 ADD 1 TO #CONTROL.#CT-POS
0780 ADD 1 TO #CONTROL.#CT-PAGE
0790 MOVE #AF_CTX (#CT-POS) TO #AF_PRI_FIRST-NAME-1(#CT-PAGE)
0800 MOVE #AE_CTX (#CT-POS) TO #AE_PRI_SURNAME(#CT-PAGE)
0810 MOVE #AL_CTX (#CT-POS) TO #AL_PRI_STREET-NUMBER(#CT-PAGE)
0820 MOVE #AN_CTX (#CT-POS) TO #AN_PRI_ZIP-CODE(#CT-PAGE)
0830 MOVE #AO_CTX (#CT-POS) TO #AO_PRI_CITY(#CT-PAGE)
0840 MOVE #AM_CTX (#CT-POS) TO #AM_PRI_COUNTRY (#CT-PAGE)
0850 IF #CONTROL.#CT-POS GE #CONTROL.#CT-RES ESCAPE BOTTOM
0860 IF #CONTROL.#CT-PAGE GE #CONTROL.#MAX DO
0870 MOVE TRUE TO #CONTROL.#MORE
0880 ESCAPE BOTTOM DOEND
0890 LOOP
0900 * Start: Final Handling
0910 IF #CONTROL.#RETURN EQ 0 DO
0920 IF #CONTROL.#CT-RES =0
0930 MOVE 8 TO #CONTROL.#RETURN
0940 DOEND
0950 * End: Final handling
0960 END

Technical Information
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Parameter Structure
1. CONTROL-Structure
#RETURN (output parameter)

The following return codes are possible:

Return | Description

Code

0 All data is transferred without error.

4 Buffer of data is transferred without error; more data available.
This indicates for thdirect mode  that not all records could be retrieved because ¢f a
too small output array definition at the client side or a result set that is larger than the 30
KB limit.
This indicates for theontext mode  that more records are available and can be
retrieved with a subsequent call.

8 No data with this selection found.

12 Record limit is exceeded at the primary file.

14 Record limit is exceeded at the secondary file.

16 Result record limit is exceeded. This limit depends on the limitations given by the njax.
possible result records and the user settings concerning the limit of result records.

#MORE (input and output parameter)

Flag that shows wether another page can be delivERdH or wether this is the last pageALSE). In
direct mode, this parameter is always sdtAb. SEwhat means that it is not used.

#LIMIT (output parameter)

Information for the client that indicates how many records can be processed.

#CT-RES (output parameter)

Result-Counter: Indicates how many records were found with the current selection.
#CT-POS (output parameter)

Counter-Position: For each page returned, the counter indicates the number of the last record.
CT-PAGE (output parameter)

Counter-Page: Indicates how many records the current page contains.
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#MAX (input parameter)
Is set by the client application to indicate how many records can be retrieved by the dynamic output array.
2. INPUT-Structure

Input parameters that have to be defined by calling the service. The parameters used by defining the
transaction can be taken over into the RPC service. They referdgrtamic input variablegSuper
Natural.

Naming Conventions of Input Fields
#<unique identifier_<dynamic fiele_<field name

Example:

#BI_DY_NAME-START

3. OUTPUT-Structure

Dynamic array. The limit of the array is set by the client. It contains all output fields in the order as
selected in the transaction.

Naming Conventions of Output Fields

The names for the interface fields are set up with naming conventions as described as follows. Each name
can be max. 32 byte.

#<unique identifier_<field source_<system function identifigr_<multiple fields or periodic group
identifier>_<field name

* if used in the transaction
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Part of the Name Description
Unique Ildentifier Super Natural Field Reference
Field Source Possibilities:

e primary file (PRI)

® secondary file (SEC)
® |ookup file (F)

e user field (U)

e workfile field (U)

® dynamic variable (U)

® system variable (S)

System Function ldentifier Appears only in Summary mode.
Multiple Fields and / or Periodic Group Identifier Appears only for database arrays.
Field Name Name of the field used.

Example:

#AY_PRI_MAX_P2M2_BONUS

Periodic groups and multiple fields are flatterned for the RPC service for performance purposes as
follows:

Elementary Field Multiple “alue Field

[Marne] [Job Tite) J“\/
| H Brown | H f\/ | H |
“Walue 2 DEA

leads to

M, M,
DE" /.\V Pragrammer /\/

Eroowm

>
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Overview of the Modes and Options

Generation Modes

Direct Generation Mode

Context Generation Mode

Returns all result data with one
call.

Returns the result data with multiple calls (where conversation
RPC mode is required).

The result data amount is limit
to 30 KByte (general limitation

The result data amount is limited to 32 KByte for every field
(general limitation for Natural arrays). Occurrences of an outp

enables the usage of the RPC
service in local environments f
example testing requirements.

service is possible.

Record Limit

The Record Limit informs you about the maximum possible number of records that can be retrieved by
the RPC service. This depends on the generation mode, the used transaction, possibliy used summary

mode and the largest field used in the output data. For an example seeRieCtimsult data

Generation Modes and PRC

The following table gives you an overview of the Generation Modes and the possible RPC modes. For

Conversation Modes

further information sedlatural Mainframe DocumentatisectiorPrinciples of the Natural RPC.

Direct Generation Mode

Context Generation Mode

Conversational

RPC It may be

Not required for the RPC service itsel

Natural PRC service is part of a set 0
RPC services to be executed togethe

Required for the PRC service to
hold the conversation until all datg
buffers are received by the client.

recommended if the Super

Non-Conversational

RPC executed

Recommended if the RPC service is

Not recommended as only the firs
data buffer can be received by the
client. The others will be lost

because the conversation is not h

as a single.

Technical Information

al

it

for Natural subprogram array are treated as single fields. As the result data is organized in

parameters). For an example g output records, the largest field of the record defines the numier of

sectionRPC result data records of the result data. The result data retrieved with one call is
limited to 30KByte. For an example see sed®@BR result data

All result data is immediately |The result data is stored in the RPC-specific context area and|can

available for the client. This | be retrieved buffer by buffer to the client. No local use of the RPC

DId.

Create the Client Side Parameters

The client side parameter structure can be created easily by using the RPC service and the Natural local

data area editor as follows:

» To create the client side parameters
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1. Open the Natural local data area editor by entering the following conedand:
2. Enter in the first editor line the line commahd(your object name)>
3. Press Enter.

The following window appears:

NATO0082 Invalid command, or object NSN-RPC does not exist in library.

Local Library EXCEL DBID 167 FNR 32
Command >+

I TL Name F Leng Index/InityEM/Name/Comment
All - - -

. i (r-context>! !
! Data Area Editor !

|

!

I Please select : !

! !

I _ Alllocal variables and parameters !
I _ Alllocal variables !

I _ Only internally defined local variables !
I _ All parameters !

|
|
|

_ Only internally defined parameter !
!

SO0 L1

4. Select All Parameters.
5. Press Enter.
The parameters are separated from the coding.
6. Save them as a local data area.
7. Export them to the client environment.

Note:
Before stowing the local data area, the dyn&@idTPUTarray must be defined by a concrete value.

Memory Requirements

Super Natural is a Natural application and as such follows theNaturalrecommendations for applications.
However, because Super Naturalgenerates programs, it is advisable that you follow the recommendations
below when setting your session parameters:
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Buffer Size
DATSIZE 50
ESIZE * 45
RUNSIZE 20

* ESIZE is dependent on the size of the DDMs you are dealing with and the number of fields used.
Some transactions may need larger values than those listed above.

Example

The sample transacti@@AMPLE2 described in the section Sample Transactions istiper Natural
User’s Guidehas the following transaction specification:

Primary File SAG-TOURS-E-CRUISE

Display Fields 1A: START-DATE
1B:END-DATE
2:CRUISE-PRICE
3:CRUISE-ID

4: START-HARBOR
5:DESTINATION-HARBOR
6: CHARTER-YACHT-TYPE

Control Fields 1: START-DATE

System Function Minimum on field CRUISE-PRICE
Sort Field 1: START-HARBOR

Selection Criteria AT GE 500

The transaction results in the following sizes:

ESIZE 6608 Bytes
DATSIZE 612 Bytes
Buffer Pool 2684 Bytes

Example

The sample transacti®@AMPLES3 described in the section Sample Transactions iStiper Natural
User’'s Guidehas the following transaction specification:
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Primary SAG-TOURS-E-CRUISE
File

User Fields MY-START-DATE
MY-START-YEAR
MY-START-MONTH
MY-START-DAY
MY-END-DATE
MY-END-YEAR
MY-END-MONTH
MY-END-DAY

Display 1. CRUISE-ID

Fields 2:START-HARBOR
3:DESTINATION-HARBOR
4A: MY-START-DATE
4B:MY-END-DATE

Selection |CHARTER-YACHT-TYPE = ‘ATLANTIC 29’
Criteria

Calculation MY-START-DATE=MY-START-DAY!'IMY-START-MONTH!'."IMY-START-YEAR
Statement | MY-END-DATE=MY-END-DAY'!'"IMY-END-MONTH!."IMY-END-YEAR

Logical 11 < START-DATE GT 19910701
Conditions|1 T < MY-START-DATE ='TOO LATE
Statement |1 T < MY-END-DATE ="’

The transaction results in the following sizes:

ESIZE 8325 Bytes
DATSIZE 564 Bytes
Buffer Pool 2392 Bytes

Communication with Other Applications

Super Natural can be invoked from any other Natural application and you can invoke any other Natural
application from it.

When Super Natural is invoked from another application, you can ensure that you are returned to it when
exiting Super Natural by using the Natug2TURommand because Super Natural always terminates
with theRETURMommand.

Every application which is invoked from Super Natural must terminate witRET&JRNcommand to
ensure that Super Natural is reactivated.
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The Technical Information Function

TheTechnical Information

environment as in the following example:

Technical Information

function provides you with technical information concerning your

18:01 *4k% Super Natural ***** 1999-04-28
SN1110 - Transaction List - Friday
More: +
Cmd Na + Technical Information +
* I NSN Version ......... 331 Operating System .. MVS/XA !
__ AD! PersonalDB-File ..... (0,90) TP Monitor ........ COMPLETE!
___AS! Device Type ....... PC !

AU ! Natural Version ..... 3.1.3 !
CH ! PREDICT Version ..... 4.4.1 AOS Version ....... 0.0.0 !
CO ! CON-NECT Version .... 0.0.0 NSC Version ....... 3.13 !
Co! !
CO ! Buffer Sizes: Esize.. 35k DATsize ... 45k Usize..31k !
Co! Fsize .. 20k SORTsize .. 10k Csize.. 1k !
Co! !
CO ! Last Error Number ... 1 !
DA'! Last Error Program .. Last Error Line ... 34 !
___ DA! !
Add __ ! Program: was cataloged at !
! !
Cmd(s): +

+

Command ===>
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

If you phone Software AG Customer Support because an error has occurred, you may be asked to enter a
Super Natural module number in the Program field to obtain cataloging information.

The Technical Information function is always available.

Layout Members

When you save, run or execute a transaction, a copy code layout member is created with the name
layout-prefix transaction-name. When you keep a transaction, a layout member with dummy copy code is
created. Before you have kept, saved or run a transaction, the name transaction-nameis reserved for its
layout member. You only see the work-in-progress layout name in exceptional cases (after power cut etc).

Passwords and Cipher Code

If Adabas security is being used, passwords or cipher codes can be set either for users or for files in the
Super NaturalAdministration application. The passwords and cipher codes are read from the user profile
each time a transaction is modified. Because this does not take place at run time, security errors caused by
password changes may occur if a transaction is not regenerated.
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User Profile, Option and Adabas Password Hierarchies

User Profile Hierarchy

The administrator defines which files a user may use and specifies settings for profile, layout and options.
The user can modify certain options and defaults from the Modify Profile screen in Super Natural
Processor. The user can only modify options he is authorized to use. The user-defined profile overrides the
profile set by the administrator. The user can also override his own user-defined profile just for the current
transaction using th@ePTIONSndVMODE$&ommands.

1

Options and hdodes
(for Transaction)

2
Profile =et by Us=r

3

Frofile dset by Adminstratas)

Option Hierarchy
Options set for a file in the file profile override options set for a file in a user profile.

When you add (link) a file to Super Natural, the file has no option settings and no user list. The individual
file settings which are part of each user profile are valid for users when accessing this file if you leave the
options settings and/or the user list blank.

1

Cptions Set h Fie Profile

2

Options Set h User
Profile

Adabas Password Hierarchies

Adabas passwords control file access. The hierarchy of Adabas passwords is as follows:
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1

UszrperFie

2
Fie

Usar

Passwords on upper levels have priority and are used if provided.

When an Adabas password is provided, it is generated for each transaction program or prototype program
(except for those which access user files) as a NBRHASEWORSatement. When a program containing
aPASSWORG@Bause is modified, the password entry that is active at modification time is used.

Adabas passwords and cipher codes affect existing transactions.
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